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1 Introduction
Overview

HP Insight Control power management (power management) is a component of HP Insight Control to work
onWindows and Linux, and HP-UX 11i v3 Base Operating Environment to work on HP-UX. Power management
is an HP Systems Insight Manager (Systems Insight Manager) plug-in application that provides centralized
monitoring and control of server power consumption and thermal output, sets power regulation policies for
groups of servers, and optimizes and controls usage of data center power and cooling facilities.
Insight Control power management differs from other management applications in three key areas:

• Automated power collection. After you enter power management configurations, power management
automatically sends commands to appropriate systems for action.

• Operating system independence. Insight Control power management supports all operating systems
that are supported on ProLiant and Integrity servers, and BladeSystem c-Class enclosures. For a list of
these operating systems, see http://www.hp.com/go/supportos.

• Demonstrated power management savings. Insight Control power management displays the
monetary savings in a convenient and easy-to-read format.

• Power Control. Insight Control power management controls and adapts power/thermal footprint by
changing the Power Regulator mode, adjusting the Power Cap setting, or invoking the user created
pre-defined rules and actions.

Insight Control power management enables you to:

• Define and execute rules for responding to environmental emergencies and other events requiring
changes in data center power usage.

• Visualize the layout of devices in racks and data center floors – summarizing temperature and power
consumption.

• Graphically summarize the power/thermal capacity and utilization of your power and cooling
infrastructure, including warnings on potential errors, lack of redundancy and anomalous
configuration/monitoring data.

• Import/export power and location configuration data from spreadsheets, and configuration management
repositories.

• Graphically monitor and manage power consumption for a single c-Class enclosure, a group of c-Class
enclosures, a single system/power delivery device, a group of systems/power delivery devices, or a
mix of the above systems using a central user interface. Also, monitor and manage power consumption
for a data center and a rack.

• Group systems logically and physically using native Systems Insight Manager collections and views
grouping capabilities (for example Rack 42 or All Exchange Servers).

• Change the Power Cap setting for one or many systems at a time.

• Review CPU performance including the impact of power-saving technology.

• Chart inlet air temperature for a single system, a group of systems, a single c-Class enclosure, a group
of c-Class enclosures or a mix of the above systems. View a visualization of 24-hour peak temperatures
across a data center floor, and within each rack.

• Download historical data in CSV format to create customized reports.

• View dashboard analysis data, including power savings due to HP Power Regulator technology, for a
single system or group of systems.

• Quickly and easily configure/change Power Regulator settings across multiple systems.

Overview 9
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2 Key concepts
Data centers, racks, and power delivery devices
Data centers

HP Insight Control power management enables you to define the data center physical topology like location
with racks containing systems, enclosures, and devices. A data center is an arbitrary rectangular grid that
allows you to specify the placement of racks. You may create data centers to describe a lab floor or a portion
of a computer room – that provides a useful grouping for to summarize your environment and its power and
thermal requirements. Insight Control power management provides ease of managing and monitoring, and
positioning the racks in a data center.
Data Centers are displayed in the Systems Insight Manager System and Events Collections pane in the
collection named All Data Centers. By convention, power management shows racks running fromWest-to-East
with North displayed to the top of the screen.

Racks
HP Insight Control power management enables you to define/create a rack to mount enclosures, systems,
and other unmanaged devices, and provide power delivery topology, redundant and uninterruptible power
supply to the devices in it. Insight Control power management also enables you to describe and summarize
unmanageable system or power delivery devices.

Power delivery devices
HP Insight Control power management enables you to create the power distribution device objects, to
describe the power source for one or more components in the rack. Define Power Delivery Device should
only be used to describe power delivery devices that cannot be discovered by Systems Insight Manager.
For intelligent PDR/PDU devices, the power properties are configured during discovery through Systems
Insight Manager. Do not use this dialog to create a Power Delivery Device that has a discoverable network
accessible management module.
The power delivery devices are displayed in the Systems Insight Manager System and Events Collections
pane in the collection named All Power Delivery Devices.

Power Topology
A typical power network topology in a data center includes power feed, PDRs, PDUs, racks, enclosures, and
servers. The following figure illustrates a typical power network topology.

Data centers, racks, and power delivery devices 11



Power delivery hierarchy
Power is provided through a set of power delivery devices. Insight Control power management represents
places that can be monitored in the power delivery points of the hierarchy such as PDU load segment output,
PDU outlet, and so on, or a place where you may want to aggregate and report on power consumption of
a set of devices like servers.
Describing the power delivery hierarchy in power management allows power management to report on
overall infrastructure utilization, providing you with knowledge that enables you to fully utilize the available
capacity while at the same time reducing the risk of overloading the power/cooling infrastructure. Depending
upon the types of power delivery equipment in your data center, and the level of detail you desire, there is
significant flexibility in how you describe the power delivery hierarchy to power management.
A fully described power delivery hierarchy may contain all of the following elements depending upon your
needs:

• Power Feed: A top-level input of power from the data center facility into the power
management-observable power infrastructure.

• Breaker Panel: This represents the total group of breakers on a single Breaker Panel in a PDR.

• Branch Circuit: This represents a single output of a PDR circuit breaker and the PDU to monitor the
actual circuit power consumption.
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• Rack PDU: Rack Power Distribution Unit - This represents the input power and multiple outputs to load
segments.

• Load Segment: This represents each of the outputs of the PDU that can be monitored. HP PDU
Management Module discovers up to the Load Segment level of the power topology.

• Outlet Bar: This represents the division of the load segment into multiple outlets.

• Outlet: A circuit with one input and one output that can be monitored.

• Load: The power consumer connected to the outlet. The load can be a system, enclosure, or
undiscoverable system.

Power Summary meter
The Power Summary meter provides an overview of the power capacity and consumption for a given power
delivery device or power consuming system. The following figure shows all possible parameters of power
capacity and consumption, however, often only a subset of values will be available.

Power Summary meter Information

• Peak Observed Power: Peak of power consumption values concurrently observed for all attached
devices. For non-observable devices, the Maximum Possible Power Consumption (as configured
through the power management properties for the system) will be used. This is not the sum of the peak
power consumption over all devices – that is a higher value than the peak sum of power consumed at
any given time. The Peak Observed Power is shown in Amps and Watts.

• Calibrated Max Power: Sum of the maximum theoretical power consumption of all attached devices.
The Calibrated Maximum Power is shown in Amps andWatts. For non-observable devices, the Maximum
Possible Power Consumption (as configured through the power management properties for the
system) will be used.

• Power Cap (Yellow dot): Sum of capped power consumption for all attached devices. For capped
devices, the cap value will be used. For non-observable devices, the Maximum Possible Power
Consumption value will be used. The Power Cap is shown in Amps and Watts. The Power Cap is
obtained from the management processor for the associated system. This is the most recent value
detected by power management.

• Capacity: The available or maximum power limit of the power delivery device. The Capacity is shown
in Amps and Watts. The reported capacity is determined as follows:

• Power Delivery Devices: The capacity is the lower of the specified Rated Capacity, Derated
Capacity, or Power Limit specified in the power management configuration for the system.

• Rack: The capacity is the lower of:

• The sum of capacities of all power delivery devices associated with the rack. If any device
in the rack has the “System required redundant power” option selected, then the total capacity
is divided by 2.

• The Thermal Limit value as specified in the Rack Editor (define/edit rack page).
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• Line Voltage: The line voltage of the data center that is delivered to the observed device. The Line
Voltage is shown in Volts and used to provide translations from Amps to Watts. If no line voltage is
available from the device, the value from the Power Management Options screen is used.

• Excess Capacity: The power capacity that cannot be used for the current configuration and is available
in excess to accommodate and deliver power to more systems. The Excess Capacity is shown in Amps
and Watts.

• Headroom Capacity: The spare cap capacity that is identified from the difference between the peak
power consumption and Power Cap. This helps to identify the power delivery devices with power caps
that can accommodate another system within the already set power cap. The Headroom Capacity is
shown in Amps and Watts.

• Peak Power Observed Time: The date/time at which the peak power consumption is observed.

• Operating Range (Horizontal Bar): The center bar shows the theoretical range of minimum and
maximum power consumption of the systems being summarized.

Power Status Alerts
The Power Status column provides a description of problems resulting from an analysis of the configuration
along with recommended actions to resolve the problem. The different categories of analysis are:

• Configuration Incomplete: Displayed when a power delivery device or system needs additional
manual configuration in order for power management to provide further analysis. Conditions which
can lead to this analysis message include:

• A power delivery device does not provide all the data displayed in the Power Summary meter.

• A system attached to a power delivery device has not yet been discovered by Systems Insight
Manager.

• A power delivery device has a peak power reading that is larger than the maximum possible
consumption of all the attached systems.

• A power delivery device does not provide a rated or derated capacity.

• Configuration Error: Displayed when attributes of a power delivery device or system are inconsistent
with one another and need manual attention to resolve the problem. Conditions which can lead to this
analysis message include:

• A power delivery device has a minimum possible consumption which is greater than its maximum
possible consumption.

• Potential Overload: Displayed when conditions on a power delivery device or system could lead to
a potential power or thermal overload. Conditions which can lead to this analysis message include:

• The maximum possible (or capped) consumption of a system exceed the capacity of its power
supplier.

• The aggregate maximum possible (or capped) consumption of a rack exceed its thermal limit.

• Redundancy Error: Displayed when a system that has been marked as requiring redundant power
(as specified in the 'System Properties') does not have redundant power feeds. There are two conditions
checked as part of redundancy analysis:

• A system must be connected to at least two power delivery devices, that is, one on side A and
another one on side B.

• The power delivery devices must not have a common parent anywhere in their power hierarchy.
For example, if a system is connected to two PDUs, those PDUs must not be connected to the same
PDR or branch circuit.

Data Center Power Control
HP Insight Control power management provides you the Data Center Power Control facility to control power
and cooling for the systems in the data centers. Usually, data centers have the required power and cooling
capacity for the supported systems they contain. When the power and cooling capacity is interrupted or
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reduced, the consumption must be adjusted to match the change. Some examples of sudden capacity
reduction include loss of external power, chiller failures, and utility company demands for cutbacks.
The Data Center Power Control facility provides a means to pre-define the responses to such events, creating
flexible rules in Systems Insight Manager that can be invoked when such events occur. The rules can determine
the set of systems that need to be adjusted based on criteria evaluated when the event occurs. The rules also
specify actions that should be taken on those systems. These rules allow for flexible event responses such as
"shut down all of the low-priority systems in the data center and make the medium-priority systems operate
in low power mode."
Some of the other scenarios are:

• Data center monitoring detects that an external power source has failed, or is about to fail. The data
center continues to operate on a backup power source, but load must be reduced to make the best use
of the limited capacity of the UPS.

• Data center monitoring detects that a chiller has failed, or is about to fail. The data center continues to
operate, but load must be reduced so the data center stays cool (and the critical workloads stay up)
as long as possible.

• Data center management is asked by the local utility company to reduce data center power usage by
some proportion.

• A failure in a primary data center triggers the need to bring up a standby data center.

The Data Center Power Control facility can be used to handle all of these scenarios and many others.
The Data Center Power Control facility has two pages. The Data Center Power Control Rules page is
used to define rules and the Data Center Power Control page is used to invoke the rules.

Security properties
Protocols and ports numbers

Insight Control power management uses the following ports or external interfaces to aid administrators in
deployment and proper operation of the power management features:

Default port numberProtocolSystem/Device

443SSLHP ProLiant and Integrity iLO

443SSLHP c-Class Onboard Administrator

22SSHServers

5989WBEM HTTPSIntegrity Servers

161SNMPPDU/PDR

50443SSLHP Monitored PDU

Configuration for PDR/PDU monitoring via SNMP
HP Monitored PDRs/PDU, and third party PDUs utilize the SNMP protocol to enable discovery and monitoring.
The interface that allows network communications to the PDR/PDU is called the PDU Management Module.
To enable SNMP-based monitoring and discovery of the power delivery hierarchy, perform the following:
1. Ensure that the appropriate SNMP Read community string specified in the Systems Insight Manager

Global Credentials page, or on the system’s System Credentials page, matches the community string
in use on the management module.

2. Enable SNMP protocol on the device via its management interface.
3. For HP PDRs/PDUs you must additionally specify the address of the Systems Insight Manager CMS as

an SNMP Manager in the management interface of the PDR/PDU.

Configuration for PDU Monitoring via SSL
If your HP Monitored PDU supports discovery/monitoring via the SSL protocol, you must provide the
appropriate sign-in credentials for the system in the HP Systems Insight Manager Global Credentials page,

Security properties 15



or by configuring HP Systems Insight Manager system-specific credentials. If no valid credentials are available,
power management will additionally attempt the factory default log-in credentials, admin/admin.

Credentials
Log-in credentials are presented to all systems as configured within the Systems Insight Manager Security
and power management options. Note that use of global credentials will cause all credentials to be presented
to systems during discovery. Untrusted or compromised systems may then observe the incoming credentials
and use them for attacks upon other systems. It is therefore recommended that only system-specific sign-in
credentials be utilized to limit potential disclosure of log-in credentials.

Use of management LAN
HP recommends that all communications between the Systems Insight Manager CMS and the management
processors be transmitted over a secure LAN isolated from the remainder of your network. This ensures
SNMP data collection (which is inherently insecure) cannot be observed/monitored by other entities, and
reduces the potential for external attacks on management processors by untrusted or compromised systems.

Security properties for Data Center Power Control
In order to define and manage rules, you need to have access to the Data Center Power Control Rules page.
Access to this tool is controlled by standard Systems Insight Manager tool authorizations. Alternatively, it is
possible to define and manage rules if you have write access to the directory on the CMS in which the rule
definitions are stored. Access to this directory is controlled by standard file system permissions of the underlying
operating system. Systems Insight Manager is installed with write access to this directory granted only to the
administrator of the CMS.
In order to invoke a rule, you must either have access to the Data Center Power Control Rules page or be
on the list of Systems Insight Manager users allowed to run the rule. Authentication of the user is performed
through standard Systems Insight Manager authentication mechanisms (GUI, SOAP, or CLI).
When running a rule, the rule acts with full authority (user "mxadmin") on all target systems, regardless of
the privileges of the user who invoked it. Rule execution therefore acts as a privilege elevation mechanism.
In particular:

• The Shutdown tool is implemented by calling SSA tools run under users, 'Administrator' for the Windows
target systems and 'root' for the Linux and HP-UX target systems, with appropriate SSH credentials. For
target systems that do not allow the root SSH login, use Systems Insight Manager's privilege elevation
tool. You can log-in to target systems using appropriate SSH credentials stored in Systems Insight
Manager along with any privilege elevation credentials needed when the rule is executed. For information
on configuring SSH on target systems using Insight managed system setup wizard, see Enabling system
shutdown through Data Center Power Control.
For more information on SSH credentials and Systems Insight Manager's privilege elevation tool, see
the Secure Shell (SSH) in Systems Insight Manager 5.x white paper and HP Systems Insight Manager
Installation and Configuration Guide for Microsoft Windows, Linux, and HP-UX at http://
h18013.www1.hp.com/products/servers/management/hpsim/infolibrary.html.

• The Power State tool is implemented by connections to the system iLOs that use the iLO credentials
stored in Systems Insight Manager.

• The Power Switch action is implemented with a mix of SSA tool invocations, as with Shutdown above;
and calls to the Power State action, as described above.

• The Run Script action runs scripts on the CMS as the Administrator/root user (that is, the user running
the Systems Insight Manager CMS process).
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Power Regulator
HP Power Regulator for ProLiant

HP Power Regulator for ProLiant is a hardware feature that enables ProLiant servers to control performance
states (p-states) of the system processors. Insight Control power management monitors and uses HP Power
Regulator technology.

• CPU frequency: A lower p-state causes the CPU to operate at a lower frequency. For example, a
3.773 GHz processor might operate at 3.0 GHz in a lower p-state.

• CPU voltage: A lower p-state causes the CPU to operate at a lower level of voltage. For example, a
CPU operating at 1.4v at maximum p-state might operate at 1.2v in the minimum p-state.

Power Regulator operates in four modes:

• HP Static Low Power Mode. Power Regulator keeps the CPU in the lowest supported power state.
This mode saves maximum resources, but it might affect system performance if processor utilization
stays at or above 75% utilization.

• HP Static High Performance Mode. Power Regulator keeps the CPU in the highest supported power
state. This mode ensures maximum performance, but it does not save any resources. This mode is useful
for creating a baseline of power consumption data without Power Regulator.

• HP Dynamic Power Savings Mode. Power Regulator sets the processors to the appropriate power
level based on the utilization of each CPU core during the last 1/8 second. The CPU is set to the power
saving p-state if the CPU utilization can be maintained at the slower CPU frequency. The CPU is set to
the maximum performance p-state if the CPU utilization requires the fastest CPU frequency.
The point at which Power Regulator shifts from the minimum p-state to the maximum p-state varies based
on the processor installed in the system. A 3.773 GHz CPU that has a 3.0 GHz minimum p-state
frequency switches modes at around 75% utilization. A 3.2 GHz CPU that has a 3.0 GHz minimum
p-state frequency switches modes at around 88% utilization.

• OS Control Mode. Power Regulator configures the system to enable the operating system to control
the p-states. Moving from this state to any of the three previous states requires a system reboot.

NOTE: On ProLiant G5 systems equipped with AMD processors, setting Power Regulator for ProLiant to
HP Static Low Power mode will defeat any power cap setting. HP recommends that Power Regulator for
ProLiant be set to HP Dynamic Power Savings mode.

HP Power Regulator modes such as Static Low Power Mode, Static High Performance Mode and Dynamic
Power Savings Mode work for any operating system. The OS Control Mode requires Microsoft Windows
Server 2003 SP1 or later or Red Hat Linux 4 Update 2 or later.
For more information on supported processors, see http://www.hp.com/servers/power-regulator.

HP Power Regulator for Integrity
Although power monitoring operates independently of the operating system, HP Power Regulator for Integrity
requires a compliant operating system version. Consult operating system documentation for details on power
management support for your system. Power regulation also requires p-state capable hardware.
Power Regulator for Integrity operates in four modes:

• HP Static Low Power Mode. Power Regulator for Integrity sets the processors to the power-performance
state (p-state) with the lowest power consumption and forces them to stay in that state. This mode saves
the maximum amount of resources, but it might affect the system performance if processor utilization
stays at or above 75% utilization.

• HP Static High Performance Mode. Power Regulator for Integrity sets the processors to the p-state
with the highest performance and forces them to stay in that state. This mode ensures maximum
performance, but it does not save any resources. This mode is useful for creating a baseline of power
consumption data without Power Regulator for Integrity.
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• HP Dynamic Power Savings Mode. Allows the system to dynamically change processor p-states when
needed based on current operating conditions. The implementation of this mode is operating system
specific, so consult your operating system documentation for details.

• OS Control Mode. Power Regulator for Integrity configures the system to enable the operating system
to control the processor p-states. Use this setting to put your operating system (including OS-hosted
applications) in charge of power management. Moving to or from this state does not require a reboot
of Integrity servers.

The HP Power Regulator for Integrity modes are available on supported platforms equipped with Dual-Core
Intel Itanium Processor 9100 series 1.6 GHz dual-core parts.

Understanding HP Power Regulator savings

Server power consumption savings from HP Power Regulator
The resources saved by HP Power Regulator vary significantly from system to system, based on each system
configuration and utilization.
At higher utilization, Power Regulator saves more power. When the OS is idle, modern Intel and AMD
processors are put into a halt state that consumes minimal power.
The following figure shows Watts consumed and relative workload at various workloads for each Power
Regulator state. The system used in this test is an HP ProLiant DL380G5 with two Intel Xeon 5080 CPUs.

Analysis of power consumption
In HP Static High Performance Mode, power consumption ranges from 339 W in an idle state to 558 W
at 100% utilization. This is an example of power consumption without the benefit of Power Regulator
technology.
The green line shows power consumption in HP Static Low Power Mode ranging from 339 W at idle to 475
W at 80% utilization and to 497 W at 100% utilization.
The blue line shows power consumption in HP Dynamic Power Savings Power Mode ranging from 339 W
in an idle state, to 475 W at 80% utilization, and to 558 W at 100% utilization.
An idle system consumes the same power (339 W) regardless of the Power Regulator mode.
Additionally, the power consumed in HP Dynamic Power Savings Mode matches the power consumed in
HP Static Low Power Mode from idle to 80% utilization because this system is running in the lower processor
p-state from idle to 80% utilization when it is in the Dynamic Mode. In Dynamic Mode, after 80% utilization,
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the system shifts into the highest processor p-state and the power consumption for 90% and 100% workload,
and matches the power consumption in HP Static High Performance Mode.
The line graphs show that the power saved by HP Dynamic Power Savings Mode increases as the workload
approaches 80% utilization. If the system is configured for HP Static Low Power Mode, it continues to save
increasing amounts of power up to 100% utilization.
The wider the gap between the red line and the blue or green line, the more power is saved.

Analysis of throughput
In the above figure, 1.00 throughput represents the maximum work that can be accomplished by a system
regardless of the Power Regulator mode. All other throughputs are relative to this 1.00 value.
The red bar shows the normalized throughput (or work accomplished) in HP Static High Performance Mode.
In this mode, the relative throughput ranges from no throughput in an idle state up to 1.00 at 100% utilization.
This is an example of the relative throughput without Power Regulator technology.
The green bar shows the normalized throughput in HP Static Low Power Mode. In this mode, the throughput
ranges from no throughput in an idle state to 0.79 at 80% utilization, and to 0.93 at 100% utilization.
The blue bar shows the normalized throughput in HP Dynamic Power Savings Mode. In this mode, the
throughput ranges from no throughput in an idle state to 0.79 at 80% utilization, and to 1.00 at 100%
utilization.
The normalized throughput for all three Power Regulator modes is identical up to an 80% workload. This
indicates that the workload can be completed at either the higher processor p-state (HP Static High Performance
Mode) or the lower processor p-state (HP Static Low Power Mode/HP Dynamic Power Savings Mode). At a
90% to 100% workload, the HP Static Low Power Mode has insufficient CPU cycles at the lower processor
p-state to complete the workload that can be accomplished at the higher p-state.

Conclusion
The previous figure illustrates:
1. HP Static Low Power Mode and HP Dynamic Power Savings Mode save resources when compared to

no power management or HP Static High Performance Mode.
2. HP Static Low Power Mode saves the most resources at full utilization, but still can have some impact

on system performance at the highest levels of utilization.
3. HP Dynamic Power Savings Mode saves the most resources at the workload level just before it switches

to the higher processor p-state.
4. HP Dynamic Power Savings Mode delivers exactly the same level of performance as no power

management or HP Static High Performance Mode.
5. Power Regulator technology saves resources on systems that are busy rather than those that are idle.

Reducing cooling power with HP Power Regulator
Power consumed by the system becomes heat that must be extracted by the data center. The previous figure
illustrates that each watt consumed by the system requires another 1.0 to 1.5 watts for the environmental
control system to cool the system. Correspondingly, reducing power consumption by the system reduces the
air conditioning requirements for the system.
Insight Control power management Power Consumption and CPU Performance graphs estimate the cooling
costs saved.

Avoiding data center expansion
Data center expansion/construction costs an average of $22,000 per square foot. Insight Control power
management can help you determine if your existing data center can support additional systems. Using
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Insight Control power management to avoid or even delay new data center expansion can save your company
thousands of dollars. Insight Control power management provides you the following advantages:

• Knowledge to optimize power confidently

Reclaim trapped power and cooling capacity•

• Extend the life of the data center

• Control to safely achieve

More complete utilization of existing power/cooling infrastructure•

• Higher uptime for mission critical applications

Avoiding power provisioning errors
For scenarios like unintentionally adding more systems and devices than the limit in a data center, or power
redundancy errors for unavailability of redundant power, any increase in power demand may lead to tripped
breakers and unexpected downtime. For such scenarios, Insight Control power management helps you to
determine the actual power required for the IT equipments and provision the required power to meet the
need without using the excess capacity to protect the power supply infrastructure.

Power Capping
Power Capping and Dynamic Power Capping

HP Power Capping and HP Dynamic Power Capping — the power management features of HP ProLiant
servers, are implemented in system hardware and firmware and are independent of operating systems or
applications. Using the power monitoring and control mechanisms built into ProLiant servers, the Power
Capping feature is specifically designed to allow an administrator to limit, or cap, the power consumption
of a server or a group of servers. This capability provides increased flexibility in data center planning by
allowing the administrator to manage data center parameters that are directly influenced by server power
consumption, including data center cooling requirements and electrical provisioning. The Power Capping
feature also allows the administrator to control server power consumption in emergency situations such as
the loss of primary AC power.
Both HP Dynamic Power Capping and HP Power Capping are designed to achieve the same general goal
of maintaining the power consumption of a server at the same level or at a lower level of a specified value,
referred to as the cap value. However, HP Dynamic Power Capping monitors the power consumption and
maintains the power cap of a server much more faster than HP Power Capping.

Enclosure Dynamic Power Capping
Enclosure Dynamic Power Capping is an enhancement of Dynamic Power Capping designed specifically
for HP BladeSystem enclosures. Enclosure Dynamic Power Capping is considered as the higher level of
power management functionality since an administrator sets and maintains a power cap at the enclosure
level and not directly at the server or blade level. Also, it can be viewed as a more powerful enhancement
of group power capping for an enclosure, since setting a power cap for the enclosure indirectly creates
power caps for the server blades within it.
For more information on power capping, see www.hp.com/go/dpc.
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3 Basic procedures
Getting started

IMPORTANT: The following steps assume HP Systems Insight Manager (Systems Insight Manager) is installed
on the Central Management Server (CMS).

Use the following guideline to set up your environment for HP Insight Control power management (power
management):

NOTE: By default, Insight Control power management is enabled now.

1. Discovering the systems. Using Systems Insight Manager Options→Discovery tasks, discover and
identify the required systems and devices.
For a list of supported systems, visit http://www.hp.com/go/insight. Under Tools and Resources, select
Technical Documentation. Under General started, select HP Insight Control Support Matrix.

NOTE: When setting up discovery tasks in Systems Insight Manager, you must provide appropriate
credentials to allow Insight Control power management to access power management features of the
managed nodes, which are required to work with the application.

When managing servers, it is recommended to have Systems Insight Manager discover both server and
management processor, that is, the list of credentials supplied to the discovery task(s) should include
credentials for both pieces of equipment.
Using default settings, the discovery of a c-class Onboard Administrator module causes Systems Insight
Manager to create systems for the enclosure and all the equipment installed in it. If an enclosure contains
server blades, Systems Insight Manager automatically discovers the management processors of the
systems. The management processors will be associated with the discovered systems or the systems
identified with the serial numbers. Insight Control power management can work with both the discovered
systems and the systems identified with the serial numbers.
When Insight Control power management is installed on the CMS, power management creates a
scheduled task automatically to identify all the management processors. When Systems Insight Manager
service is started, this task will run despite the date for the task displayed is an older date.

2. Changing the credentials. If you need to change the credentials after discovering the systems/devices,
use Options→Security→Credentials→System Credentials. After changing the credentials, Systems
Insight Manager launches the System Identification tool targeting the selected systems.

NOTE: Alternatively, if you want power management to use credentials other than those supplied for
discovery, use Options→Power Management... to enter credentials in the Power Management Options
page. These credentials will be tried for all systems before any Systems Insight Manager sign-in credentials
created during discovery.

NOTE: For any power distribution racks (PDRs) or power distribution units (PDUs) that needs to be
monitored, you must similarly configure SNMP or sign-in credentials. For any system that needs to be
managed through Data Center Power Control Administrative privileges, you must configure sign-in
credentials to enable Data Center Power Control management.

3. Deploying iLO licenses. Based on the requirement to enable the power management features on ProLiant
and entry-class Integrity servers, you need to acquire and deploy the necessary iLO 2 Advanced/Select
license keys to the system’s management processor using Deploy→License Manager.

NOTE: The ProLiant and Integrity system keys are not interchangeable.

4. Installing Insight Control License keys and applying licenses to systems. For ProLiant servers, use
Deploy→License Manager to enter your license keys and then apply the licenses to the desired systems.
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NOTE: c-Class enclosures and PDUs do not require an Insight Control license to enable the power
management application.

5. Using Insight managed system setup wizard. If managed system setup wizard is available on HP Systems
Insight Manager CMS, you may optionally use this wizard to automate and advise on the setup steps
for power management. After discovering the systems, select the systems with which power management
is to be used and then open the wizard from Configure→HP Insight managed system setup wizard.
Then, navigate to the Insight Control collection and select the desired power management features.

6. Start using HP Insight Control power management. After completing the above tasks, power management
will start collecting the power information. To start using power management, see Using power
management with Systems Insight Manager for a list of tasks that you can perform and links to those
help topics.

Licensing power management systems
Insight Control power management licenses and iLO 2 Advanced or iLO 2 Select licenses are required to
be applied to the systems and the Integrated Lights-Out (iLO 2) respectively in order to operate on systems.

NOTE: Insight Control power management licenses are not required to view monitor, analyze, and report
Integrity servers, c-Class enclosures, racks, and power delivery devices.

Purchasing additional power management licenses
Insight Control power management licenses can be purchased from the following:

• HP configure to order

• HP Software Depot

• HP Small and Medium Business (SMB) Store

• HP resellers

To purchase licenses:
1. Navigate to http://www.hp.com/go/ipm.
2. Click Buy to access the SMB store.
3. Click How to buy for instructions about purchasing licenses for HP Insight Control power management

through the following SKU:
HP Insight Control. Insight Control SKU includes licenses for the HP Insight Control server deployment,
HP Insight Control server migration, HP Insight Control virtual machine management, HP Insight Control
power management, HP Insight Control performance management, and HP Insight Control remote
management.

Managing power management license keys

NOTE: The following procedure assumes you have already installed Systems Insight Manager.

To use License Manager to manage keys:
1. Select Deploy→License Manager. The following information is displayed for each licensed product:

• Product. The name of the product.

• Licensed Systems. The number of systems licensed to use the product.

• Licenses (Select 'Manage Licenses' for detail). The total number of licenses in the License
Manager database for the product.

2. Click Add Licenses. The Add License section appears.
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3. In the Specify a key string field, enter the license key that you purchased or obtained from the Insight
Software DVD and click Open. The system is licensed and the Key details sections displays the Product,
License Version, License Type, Licenses Purchased and Days Max.

4. Click Add Licenses Now. A dialog box appears indicating the key has been added. Click OK. The
new key appears under Product License Information.

NOTE: See License Manager section in Systems Insight Manager on-line help for more information.

Licensing power management managed systems
If a system is not currently licensed, a prompt appears when you access Reports→Power
Management→Display Power/Thermal Data... or Configure→Power Management→Power Usage
Controls... indicating that licenses are not installed. You must install a license to use power management.
To install an power management license from an power management report or option page:
1. Select the power management systems to be licensed from the Systems and Events panel.
2. Click Reports→Power Management →Display Power/Thermal Data.. or Configure→Power

Management→Power Usage Controls.... The Step 1 page appears with the Status indicating the
system is not licensed.

3. Select the system to be licensed and click Apply License. The Step 2: License unlicensed systems
(optional) page appears indicating the number of license remaining.

4. Click Next. The Insight Control power management page appears.

Using power management with Systems Insight Manager
Table 3-1 Using Insight Control power management

Go toTo

Options→Power Management...Configure power management settings and display options

Deploy→License ManagerManage power management license keys

Reports→Power Management→Display Power/Thermal
Data... or Configure→Power Management→Power Usage
Controls...

License power management managed systems

Tools→Integrated Consoles→Power Management...View power information on Power/Analysis views for Physical
Location, Power Delivery, Available Power, Power Status, and
Power Summary information

Power/Analysis views > Define Rack/PowerDefine racks

Power/Analysis views > Define Data CenterDefine data centers

Power/Analysis views > Define Rack/Power > Define Power
Delivery Device...

Define power delivery devices

Power/Analysis views > Define Rack/Power > Define
Undiscoverable Systems...

Define undiscoverable systems

System and Event Collections pane > All Racks > Select a rack >
Power/Layout tab

Visualize the layout of systems/devices in a rack

System and Event Collections pane > All Data Centers > Select a
data center > Power/Thermal tab

Visualize the layout and power information for racks in a data
center

System and Event Collections pane > All Racks > Select a rack >
Power/Thermal tab

View power information for racks

System and Event Collections pane > All Power Delivery Devices
> Select a power delivery device > System and Power/Thermal
tabs

View power information for power delivery devices

System and Event Collections pane > All Enclosures > Select an
enclosure > Power/Thermal tab

View power information for c-Class enclosures

System and Event Collections pane > All Servers > Select a system
> System and Power/Thermal tabs

View power information for systems
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Go toTo

Reports→Power Management→Display Power/Thermal
Data...

View reports

Reports→Power Management→Export ReportExport reports

Power/Thermal tab > Power Management Actions > ChangeSet the Power Cap and change the Power Regulator mode

Configure→Power Management→Configure Alerts...Configure and schedule alerts

Options→Data Center Power Control Rules... or Tools→Data
Center Power Control > Define Rules tab

Define rules for responding to environmental emergencies and
other events requiring changes in data center power usage

Tools→Data Center Power Control or Options→Data Center
Power Control Rules... > Invoke Rules tab

Execute rules to control power and cooling for the systems in the
data centers

Configuring power management options
Use Power Management Options to configure HP Insight Control power management settings and display
options.
With the Power Management Options you can:

• Enable or disable HP Insight Control power management capabilities on managed systems. If disabled,
power data will not be gathered. This setting is global.

• Provide sign-in credentials for iLOs through either HP Systems Insight Manager Global Credentials (if
all iLOs use a common set of credentials) or HP Systems Insight Manager System Credentials.

• Configure a designated time range to keep historical data. The data is deleted automatically after the
specified time has elapsed. This setting is global.

• Specify the default electrical derating percentage required by your local electrical code. This setting is
global.

• Indicate whether to display temperature in Celsius or Fahrenheit. This setting is user specific.

• Indicate whether to display power consumption in watts or Btu/hr. This setting is user specific.

To configure power management options:
1. Click Options→Power Management.... The Insight Control power management Options page

appears.
2. By default, HP Insight Control power management is enabled now. To disable power management,

clear the Enable HP Insight Control power management check box.
3. Graph and Analysis Settings provide the following options:

• Temperature Unit of Measurement. Select a unit of measurement for the temperature from the
list. This setting is user specific.

• Power Unit of Measurement. Select a unit of measurement for power.

• Use GMT for all timestamps in the graphs. Select this option to use Greenwich Mean Time
(GMT) when graphing data.

• Cost of Power per kWh. Enter the average cost of power per kilowatt-hour. This calculates the
cost of operation for the system and cooling. For ease of data entry, only one field is provided.
Use the Export option in the Power Regulator Actions section of the graphs if more cost analysis
is required. This field is used to calculate the cost and annual cost of operation for the system and
cooling.

• Currency Type. Enter the currency type. This option controls the display of cost information in the
Analysis section of graphs. The default value is USD. You can specify $, EUR, €, GBP, £, ITL, £,
JPY, ¥ or any other printable character set.

• Cooling Multiplier. Enter a cooling multiplier. This value represents the relative cost of cooling
the system compared to the cost of powering the system. The default value of 1.5 indicates that it
costs 1.5 as much to cool the system as it does to power the system. This value is multiplied by the
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kilowatt-hours used by the system to obtain the cooling kilowatt-hours that are used in the Analysis
section of graphs that display power consumption.

• Power Line Voltage. Select the power line voltage. This option calculates the consumed amperage
that is displayed in the Power/Thermal Analysis views and Analysis section of graphs.

NOTE: The Power Unit of Measurement, Use GMT for all timestamps in the graphs, Cost of Power
per kWh, Currency Type, Cooling Multiplier, and Power Line Voltage options are set for each user and
the settings can vary from one user to another.

4. The rated capacity of a power delivery device is the absolute maximum load supported by the device
in amperes. In some localities, electrical codes dictate that only a percentage of this rated capacity can
be utilized to satisfy a continuous load. The default Derating Percentage identifies the portion of the
rated capacity of a power delivery device that must be reserved when calculating the maximum continuous
load supported by a power delivery device. Insight Control power management utilizes this value to
calculate the maximum usable power capacity of the power delivery device. You can select one of the
following:

• NA/JP. Select this if you are managing systems in North America or Japan which require a derating
of 20%. This is the default option.

• None. Select this if no dertating is required in your locality.

• Custom. Select this to specify a custom derating percentage other than 20%.

5. Default Integrated Lights Out (iLO) Settings enable you to configure a Secure Socket Layer (SSL)
port number. For the Default SSL Port option, enter the SSL port number to be used by power
management to communicate with iLO. The default is 443. The port number of power management and
any iLO, that the power management communicates with, should be same.

NOTE: If a non-standard SSL port is configured in the Insight Control power management Options
page, the same SSL port has to be updated in Systems Insight Manager web service properties file
available at HP SIM INSTALLED LOCATION\config\identification\additionalWsDisc.props. Failure to
do so may result in Systems Insight Manager being unable to correctly identify management processors
using the changed SSL port number. For more information, see HP SIM INSTALLED
LOCATION\config\identification\additionalWsDisc_README.txt. You also need to configure the
non-standard SSL port on the management processors.

6. Use Systems Insight Manager's sign-in credentials to configure user name and password pairs that will
be used for Integrated Lights-Out 2 (iLO 2) and Onboard Administrator access.
If you want to use credentials other than the Systems Insight Manager's sign-in credentials, you can use
power management's Default Management Processor Access Credentials option to configure user
name and password pairs that will be used for Integrated Lights-Out 2 (iLO 2) and Onboard Administrator
access. The following options are available:

• User Name. Enter the user names used to connect to the iLO 2/Onboard Administrator for the
managed systems. You can enter up to five user name and password pairs in the Default 1-5
fields. If there are more than five iLOs available, which require different credentials, you can
overwrite the existing credentials in the Default 1-5 fields to assign new credentials to the other
iLOs.

NOTE: User name can be a short name or a fully qualified domain name and cannot be in the
formats: userlogin@domain and domain/userlogin.

• Password. Enter the password for the iLO 2/Onboard Administrator of the managed system
named previously.

• Confirm password. Re-enter the password exactly as you entered it in the Password field.

NOTE: Insight Control power management tries each name and password pair on managed systems
until it accesses the power data.

NOTE: Insight Control power management allows you to configure five credentials to communicate
with iLO/Onboard Administrator. When the credentials are not configured, power management uses
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SSH credentials configured in Systems Insight Manager. If this fails, power management uses the Sign-in
credentials of Systems Insight Manager.

7. Default Power Management Data Expiration Settings enable you to configure the time to keep the
historical data.
In the first Remove data older than list, select the number that corresponds with a time span to be
selected in the second list. For example, specifying Remove data older than 6 Month(s) would delete
all data older than six months.

8. Click Apply to save your settings.

Opening the Power/Thermal Analysis view
To open or access the Insight Control power management Power/Thermal Analysis views page, perform
one of the following:

• From the Systems Insight Manager System and Event Collection pane, click All Data Centers (for
Physical Location tab) or All Power Delivery Devices (for Power Delivery tab).

• Click Tools→Integrated Consoles→Power Management....

• From any Systems Insight Manager collection view, select power or location option for the View as
field. Or, from the Systems Insight Manager System and Event Collection pane, customize a collection
to show the power or location view by default through the Customize… link.

Understanding the Power/Thermal Analysis view

The various fields, views, and components of Insight Control power management Power/Thermal Analysis
views are:

• Physical Location tab: Lists all the monitored power distribution devices and managed systems and
devices to show how they are configured and monitored from a data center level to the system level.
For more information, see Physical Location.

• Power Delivery tab: Lists all the monitored power distribution devices and managed systems and
devices to show how the power is distributed from a power feed level to the system level based on the
Power Delivery Hierarchy. For more information, see Power Delivery and Power delivery hierarchy.

• Available Power tab: Lists all the leaf power delivery devices to show the excess capacity and cap
headroom available for deploying additional systems. For more information, see Available Power.

• Edit...: Enables you to access the power management properties for any selected system or device.

• Delete...: Enables you to delete the selected systems and disconnect them from any power management
asscoications with other systems or power delivery devices.

• Define Data Center...: Enables you to define a data center. To define a data center, see Defining a
data center.
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• Define Power Delivery Device... (Power Delivery tab only): Enables you to define a power delivery
device that describes the power feed or branch circuit providing power to devices in racks. To define
a power delivery device, see Defining a power delivery device.

• Define Rack/Power...: Enables you to define a rack, power delivery devices, and undiscoverable
systems. To define a rack, see Defining a rack.

• View as: Enables you to select the Systems Insight Manager view for the current collection of systems.
The built-in Systems Insight Manager views are table, icons, and tree. The location view is associated
with the Physical Location tab and the power view is associated with the Power Delivery tab of the
Insight Control power management Power/Thermal Analysis views page.

• : Click to expand all of the discovered systems/devices.

• : Click to collapse the expanded view to show only the top level of discovered systems/devices.

• : Click to refresh the information displayed for the discovered systems/devices.

Physical Location
The Physical Location tab shows the systems of the current collection as grouped by their physical location
within the data centers and rack. Systems that have not yet been associated with a locations within a rack
are listed separately in the Physical Location Unspecified group.
The different fields/columns of the Physical Location tab are:

• Name: The name of the data center, rack, or managed system.

• System Type: The type of the data center, rack, or managed system.

• Power Status: The Power Status column provides a description of problems resulting from an analysis
of the configuration along with recommended actions to resolve the problem. For detailed information
on power status alerts, see Power Status Alerts.

• Power Summary: The power summary meter provides a visual representation of the utilization of the
power/thermal infrastructure and power details for a system or group of systems. For detailed information
on power summary meter, see Power Summary meter.

Power Delivery
The Power Delivery tab lists all the power distribution devices and managed systems to show how the power
is distributed from a power feed level to the server level based on the hierarchy of power delivery. The
ungrouped power delivery devices and systems that do not yet have their power delivery specified are
grouped and listed separately under Power Delivery Unspecified.
The different fields/columns of the Power Delivery tab are:

• Name: The name of the power delivery devices.

• System Type: The type of the power delivery devices.

• Power Status: The Power Status column provides a description of problems resulting from an analysis
of the configuration along with recommended actions to resolve the problem. For detailed information
on power status alerts, see Power Status Alerts.

• Power Summary: The power summary meter provides a visual representation of the utilization of the
power/thermal infrastructure and power details for a system/device or group of systems/devices. For
detailed information on power summary meter, see Power Summary meter.

Available Power
The Available Power tab lists all the leaf power delivery devices to show the available capacity and headroom.
The different fields/columns of the Available Power tab are:

• Name: The name of the power delivery devices.

• System Type: The type of the power delivery devices.

• Excess Capacity (Watts): The power capacity that cannot be used for the current configuration and
is available in excess to accommodate and deliver power to more systems.
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• Cap Headroom (Watts): The spare cap capacity that is identified from the difference of peak power
consumption and power cap values. This helps to identify the power delivery devices with power caps
that can accommodate another system within the already set power cap.

• Power Summary: The power summary meter provides a visual representation of the utilization of the
power/thermal infrastructure and power details for a power delivery device. For detailed information
on power summary meter, see Power Summary meter.

Understanding/Using the Physical Location
Insight Control power management can summarize the power/cooling consumption based upon the location
of the systems. Apart from the Systems Insight Manager system objects such as servers, enclosures, switches,
and so on, there are two additional levels:

• Rack containing systems: For purposes of summarizing power, large free-standing servers are also
considered racks.

• Data center containing racks: A data center is an arbitrary rectangular grid that allows you to specify
the placement of racks. You may create data centers to describe a lab floor or a portion of a computer
room – that provides a useful grouping for your requirement.

While configuration of the physical location hierarchy is optional, it enables power management to summarize
power/cooling requirements based upon physical groupings. For more information on defining data centers
and racks, see Defining a data center and Defining a rack.
Rack content is displayed in the Power/Thermal tab for the Systems Insight Manager rack object. It provides
the highest observed system inlet temperatures in the last 24 hours of data collected for each system collected
via the coloring of the system/enclosure box in the rack. Similarly, when viewing the Power/Thermal tab
for a data center, the highest temperature of any system in the rack over the last 24 hours is displayed via
coloring of the rack. Clicking on the rack name will provide the rack visualization to show which systems
are the source of the high temperature.
Understanding the Define Rack page

Understanding the Define Rack page

The various fields and components of the define rack page are described as follows:

• Rack Name: The Systems Insight Manager display name for the rack.

• Height (U slot): The height of rack. The different types of HP racks are 14U, 22U, 36U, 42U, 47U,
and 50U.
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• Orientation (front): The front of a rack facing a particular direction. The direction could be North,
South, East, or West. By convention, power management shows racks running from West-to-East with
North displayed to the top of the screen. Therefore, you may want to specify the direction to reflect the
top of the screen instead of actual compass direction.

• Thermal Limit (Watts): The thermal limit for the rack indicating the maximum desired heat that is
allowed to dissipate. This enables the Power/Thermal Analysis views to report thermal capacity
consumed/available for the rack.

• Power Delivery Devices: Contains the list of all managed and unmanaged power distribution and
power delivery devices that are not currently configured in other racks.

• Define Power Delivery Device: Click to add a new unmanaged power device. To add unmanaged
power device, see Defining a power delivery device.

• Rack: The rack with the available U slots to mount the PDUs, UPSes, enclosures, systems, and devices.

• Side A/Side B: The drop-zone areas for power distribution devices such as load segment, outlet, and
so on. The power distribution devices supply power to rack and its components through Side A and
Side B.

• Systems and Servers: Contains the list of all managed and unmanaged systems and devices that
can be placed in the rack.

• Define Undiscoverable System...: Click to define a new system/device that cannot otherwise be
discovered by Systems Insight Manager, but consumes space in the rack. To add undiscoverable
system/device, see Defining a undiscoverable system.

• Show: Contains a list of types of items for both Power Delivery Devices, and Systems and Servers
panes.

• Filter: A text field to search for the required items. You can enter the initial characters of the device
name to filter the list.

Defining a rack
To define/create a rack, perform the following:
1. From the Insight Control power management Power/Thermal Analysis view, click Define Rack/Power.
2. Enter a Systems Insight Manager display name for the rack in the Rack name field.
3. Select a rack type based on the height of the rack from the Height (U slot) field. The default rack height

is 42U.
4. Select the facing direction of the front of the rack as in the data center in the Orientation (front) field.

This enables determination of the position of input air to the rack for display purposes.
5. Optionally specify a thermal limit for the rack indicating the maximum desired heat that is allowed to

dissipate in the Thermal Limit (Watts) field. This enables the Power/Thermal Analysis views to report
thermal capacity consumed/available for the rack.

6. From the list of systems/devices available under Systems and Servers pane, select a system and drag
and drop the same in the available U slot of the rack. You can choose to position the system/device in
a particular U slot. You can also click and drag the top right corner of a system/device to extend and
occupy more U slots in the rack.
The other available options are:

• Show: Select a type from the available options like enclosure, system, PDU, and undiscoverable
device to sort the available systems and devices.

• Filter: Enter the first few characters of a name to search the available systems and devices.

• Define Undiscoverable System...: Click to add an undiscoverable system. To add an
undiscoverable system, see Defining a undiscoverable system.

7. From the list of power distribution devices available under Power Delivery Devices pane, select a
power device and drag and drop the same in Side A or Side B panes. To provide redundant power
supply to the systems or devices in the rack, you can include power delivery devices in both Side A and
Side B.

8. After the power delivery device is added in the side A or Side B, the connection points appear as
checkboxes with connection lines for the particular power delivery device and the corresponding
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available systems/devices in the rack. Click the required checkbox on Side A and Side B for a particular
system/device to supply power and monitor the device.
The other available options under Power Delivery Devices pane are:

• Show: Select a type from the available options like Power Feed, PDR, Breaker Panel, Branch
Circuit, Rack PDU, Load Segment, Outlet Bar, and Outlet to reduce the number of power delivery
devices shown. Select Any to show all devices.

• Filter: Enter the first few characters of a name to search the available power delivery devices.

• Define Power Delivery Device...: Click to add an unmanaged power device. To add an
unmanaged power device, see Defining a power delivery device.

9. Click Ok to save the changes. Or, click Cancel to discard the changes.

Defining a data center
To define/add a data center, perform the following:
1. To open the Power/Thermal Analysis page, do one the following:

• From the Systems Insight Manager System and Event Collection pane, click All Data Centers.

• Click Tools→Integrated Consoles→Power Management....

2. Click Define Data Center.
3. Enter a unique name for the data center in the Data Center name field. The naming convention should

meet the requirements of Systems Insight Manager.
4. Select the number of rows required from the Row field.
5. Select the number of racks per row required from the Racks Per Row field.
6. From the list of racks that appear under the Racks field, click and drag the required rack from the list

and place it in the required Row and Rack Per Row table. In the table, the number of rows is positioned
as rows and number of racks per rows is positioned as columns. The list of racks displayed are those
that have not already been positioned in other data centers.
For example, if you have defined the number of rows in a data center as 4 and racks per row as 6 and
to place a rack in Row 2 and Racks Per Row 6, you need to click and drag the desired rack listed under
the Racks field and drop it in the 2nd row and 6th column of the table.
You can use the other following options as:

• Filter: Enter a rack name to sort the list, based on the rack name, available under Racks field.

• Define Rack/Power: Click Define Rack/Power to define a new rack containing additional
systems. To define/add a rack, see Defining a rack.

7. Click Ok to save the changes. This creates the data center and is listed under the Insight Control power
management Power/Thermal Analysis page. Or, click Cancel to discard the changes.

Defining a power delivery device
To add a power delivery device, perform the following:
1. (Required) In the Power Delivery Device Properties dialog box, enter an unique Systems Insight

Manager display name for the power device based on the power device type in the Power Device
Name field.

2. Select the power type from the drop-down list of the Power Device Type field. The power device types
are:

• Branch Circuit

• Breaker Panel

• Load Segment

• Outlet Bar

• Outlet
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• Power Feed

• Rack PDU

For more information on the type of power delivery device, see Power delivery hierarchy.

3. Enter a brief description for this power delivery device in the Description field.
4. (Required) Enter the available power that the power deliver device can provide in the Rated Capacity

field. Use the units selector to choose whether the input value is specified as Amps or Watts. If specified
as Watts the conversion will be provided using the Line Voltage specified below.

5. The maximum continuous load allowed for this power delivery device is specified through the Derated
Capacity field. By default, the Derated Capacity is calculated from the Default Derating Percentage as
specified in the Insight Control power management Options page. To specify a derating other than the
default, click the “Override default derating” check-box to enable you to enter a value. Use the units
selector to choose whether the input value is specified as Amps or Watts. If specified as Watts the
conversion will be provided using the Line Voltage specified below.

6. Enter the desired usage limit value for the power delivery device in the Allowed Power Limit field.
This is an optional field. You may specify the value only if there is an artificial constraint that prevents
you consuming the complete derated power capacity. Use the units selector to choose whether the input
value is specified as Amps or Watts. If specified as Watts the conversion will be provided using the
Line Voltage specified below.

7. (Required) Enter the line voltage for the device in the Line Voltage (Volts) field. By default, this value
will be populated from the value configured in the Insight Control power management Options page.
If the device input is for 3-phase power, specify the phase type to enable power management to provide
the proper total power in Watts provided by the device.

8. Enter the string value to indicate the power feeds in the Feed Identifier field. For example, the value
could be A, B, A13, B19, etc., This value is for your reference only.

9. Enter a value to specify the number of connections that can be made to this power delivery device in
the Power Outputs field. If you omit this value, power management will allow any number of connections
to be made to the device.

10. Select the allowable type of power delivery device based on the type that is being defined in the
Allowable Power Connections field. The available options are:

• Any

• Branch Circuit

• Breaker Panel

• Load Segment

• Outlet Bar

• Outlet

• Power Feed

• Rack PDU

11. Click to select a power delivery device that can provide power to this system for the Powered By
field. You can select a power delivery device type from the Show filed to sort the list based on your
requirement. You can also enter the name of the power delivery device in the Filter field to sort the list.

12. Select a power delivery device from the list and click Select. To remove a device specified as Powered

By, click the and click None.
13. Click Ok to save the changes. Or, click Cancel to discard the changes.
After the power device is created through this page, this power delivery device is listed under the All Data
Centers and All Power Delivery Devices collections, Insight Control power management Power/Thermal
Analysis page, and Power Delivery Devices pane of the Define rack page.

Defining a undiscoverable system
HP Insight Control power management enables you to add and monitor the unmanaged and undiscovered
systems, such as a server, enclosure, or PDU, that takes up a U slot in the rack, but does not have Systems
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Insight Manager discoverable IP address. For all discoverable devices, the properties are included/configured
during discovery through Systems Insight Manager.
To define an undiscoverable system, perform the following:
1. From the Insight Control power management Power/Thermal Analysis views page, click Define

Rack/Power.
2. Click Define Undiscoverable Systems... under the Systems and Servers pane. The System

Properties dialog appears.
3. (Required) Enter an unique Systems Insight Manager display name for the unmanaged device in the

System Name field.
4. (Required) Enter the maximum possible power consumption of the unmanaged device in the Maximum

Possible Power Consumption (Watts) field.

NOTE: For accurate depiction of the usage of your power/cooling infrastructure, this value should
not underestimate the power consumed by the device. HP recommends using the faceplate power rating
unless another accurate maximum value can be determined.
If the system provides Calibrated Max Power, the Peak Observed Power Consumption (Watts)
information appears and the Maximum Possible Power Consumption (Watts) value cannot be
edited. To override the peak observed power, select the Override peak observed power check box
and specify a new peak value.

5. Enter the number of U slots that this unmanaged system/device could occupy in the Height field.
6. Enter the number of power connections that this device could allow on a side in the Number of Power

Connections on Side A and Number of Power Connections on Side B fields.
7. If the device does not require or expect redundant power, then clear the System requires redundant

power check box for the Redundancy field.
8. Click Ok to save the changes. Or, click Cancel to discard the changes.
After the undiscoverable system is created, the system is listed under the Systems and Servers pane of the
Define Rack page.

Describing Power Delivery Hierarchy
While there is significant flexibility in how much detail you describe power delivery hierarchy in power
management, it is critical that details that are provided be correct in order for Power/Thermal Analysis
reports to be accurate and useful.
Best practice would be to describe your power hierarchy starting from the systems/enclosures and other
power-consuming devices, adding levels until you obtain the level of detail desired from power management
analysis. Power delivery devices in the hierarchy may be monitorable to provide additional detailed power
history data. For non-networked devices without monitoring capability, monitoring data is aggregated from
the configuration data and monitoring of the attached monitorable systems.
Starting with the content of a particular rack, use the following checklist to configure your power delivery
hierarchy:
1. Ensure all power management-monitorable systems are properly discovered by Systems Insight Manager,

licensed for power management, and initial power management data collection has been done. For
more information, see Getting started

2. For Systems Insight Manager discovered and power management supported systems, configure the
maximum power consumption for the system by performing one the following:

• Click Configure in the power management section of the System page associated with the system.

• Select the system from one of the Insight Control power management: Power/Thermal Analysis
views page and click Edit.

3. Using Define Undiscoverable Systems... option, define undiscoverable systems to represent any
power consuming devices that cannot otherwise be discovered through Systems Insight Manager.
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4. Use the Rack/Power Editor to connect the power consumers to the power delivery devices providing
power to them.
a. If the power is delivered from monitorable Rack PDUs, then perform Systems Insight Manager

discovery of the PDU management modules, and make connections to the discovered Load Segments
or Outlets as appropriate.

b. If the power is delivered by non-discoverable devices, manually create the power delivery devices
as necessary using the Define Power Delivery Device... option (e.g. Rack PDU or Branch Circuit
as appropriate/desired).

5. Repeat this for additional levels of the power delivery hierarchy until you have created the highest level
of summary detail desired.
1. If you provide only the one level in the hierarchy, then power management will show the consumption

of each power delivery device defined as a simple list.
2. Creating upper levels in the hierarchy will allow for higher level summaries of capacity/consumption

in addition.

NOTE: You can also use ipmimport command from the command line utility. For more information, see
ipmimport(1M)

Finding available capacity in racks and power delivery devices
After configuring the power and physical hierarchy for your management domain, you can use the tabs of
the Power/Thermal Analysis view to determine the utilization of your power/thermal capacity and identify
those racks and power delivery devices that can safely host additional systems.
You can use the Power/Thermal Analysis view to find available capacity in,
1. Racks. From the Physical Location tab, expand any data centers to the rack level and find racks for

which there is an Excess Capacity value on the meter. The Excess Capacity considers both the limitations
of power delivery devices to the rack as well as any thermal limit specified for the rack.
The Power Summary meter shows both Excess Capacity & Headroom between any applied Power Caps
and the power capacity.

2. Power delivery devices.From the Power Delivery tab, expand any top-level power delivery devices until
the desired level of the hierarchy is visible. Then, inspect the Excess Capacity or Headroom section on
the power summary meter to identify power delivery devices that have unconsumed capacity.

For power delivery devices, you may also use the Available Power tab to directly see leaf power delivery
devices with their Excess Capacity & Headroom split out into separate columns. Click on the column headers
to sort based upon the magnitude of the excess capacity. You can also provide a secondary search key by
holding the Shift key while clicking the column header on an additional column.
Once you have identified the desired capacity you may deploy the new system using your conventional
processes.

Ensuring the sufficient availability of power and cooling for your data
center

After configuring the power and physical hierarchy for your management domain, you can use the tabs of
the Power/Thermal Analysis view to identify potential sources of power overload.
Insight Control power management automatically gathers data about the operating range of all supported
equipement and reports any potential overloads of the power delivery hierarchy by comparing the capacity
of the devices with the potential consumption of all attached devices.
Any potential issues are highlighted in red in the power summary meter and Power Status message pop-ups,
and potential errors in redundant power configuration.

Visualizing the layout of systems or devices in racks
The Power/Layout tab for racks provides a typical visualization of how a rack is configured with the power
distribution devices, enclosures, and servers.
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The name of the rack, height of the rack, and the direction of the rack information are displayed in the Rack
Name, Height (U slots), and Orientation (Front) fields respectively. The rack displays the enclosures and
systems within it and the power distribution connections on both the Side A and Side B. The color of the
enclosures and systems in a rack represents the thermal status of the particular enclosure or system. The
temperature legend is provided at the bottom of the page. The monitored temperature range is from 59
degree Fahrenheit to 86 degree Fahrenheit.
In the Power/Layout tab for racks, you can perform the following:

• Click on an enclosure or system in the rack to view the power consumption and thermal utilization
information of the particular enclosure or system.

• Click Edit Rack... to edit a rack. For more information on editing a rack, see Defining a rack.

Generating reports and graphs
HP Insight Control power management enables you to view the power and thermal utilization for a managed
system or a collection of systems.
To access the HP Insight Control power management reports:
1. Click Reports→Power Management→Display Power/Thermal Data... If you already selected one

or more target systems, the Insight Control power management page appears, and you can omit
steps 2 through 4.

2. Add multiple or single targets:
3. Click Apply. The targets appear in the Verify Target Systems page.
4. Click Next >. The Insight Control power management page appears.

NOTE: If you attempt to view power management data from multiple servers at once, with respect to the
previous 24 hours of data, your graphs may end up with unexpected results. This is due to the fact that
power management collects the sample data from the selected servers at different times of the day. To update
the graphs and view the latest information from each server, click Refresh Data.

Changing the time scale
To view the graph for a particular time frame, you can select either Fixed Interval or Range Intervaloptions.
To view the graph for a Fixed Interval:
1. In the Graphs section, select a time frame from the Most recent list. The default selection is 24 Hours.
2. Click Draw Graph.
To view the graph for a Range Interval:
1. In the Graphs section, select Range Interval for Time frame field. The default selection is Fixed

Interval.
2. Enter the date in MM/DD/YYYY format or select a date from the calendar for the From and To fields.
3. Enter the time in the At: box of the From and To fields. The default selections are 1.00 AM of yesterday's

time and 1.00 PM of today's time.
4. Click Draw Graph. The graph appears.

Refreshing the graph data
To reduce network impact, the power management application gathers data from each system and HP
Monitored PDU once daily. For other types of discovered power delivery devices, such as HP PDUs or other
vendor PDUs, data samples are collected "on-the-fly". There will be gaps in the graph data during any
periods in which Systems Insight Manager was not running on the CMS. The Refresh Data button can be
used to collect the latest data.
To refresh the data:
1. Select the licensed system. Click Reports→Power Management →Display Power/Thermal Data...
2. Click Refresh Data to retrieve the latest information from the system. The data can take a couple minutes

to refresh.
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NOTE: If Integrated Lights-Out (iLO) was recently licensed, data is minimal because data was not
collected before iLO Advanced was licensed. The minimum data collection time is five minutes and the
maximum is 24 hours.

Printing the graph
To print the graph:
1. In the Graphs section, click Print. A new window displays the graph.
2. Click File→Print...
3. Click Print.

Displaying the previous page of data
Insight Control power management can display the previous page of data for the selected time scale. If the
time scale is 24 Hours, a Previous 24 Hours link is displayed. If the time scale is 3 weeks, Previous 3
Weeks link appears.
To display the previous time scale of data:

NOTE: This example uses 24 hours as a time scale.

Above the graph, click the Previous 24 Hours link. The graph displays data for the previous 24 hours for
the selected systems.

Displaying the next page of data
Insight Control power management can display the next page of data for the selected time scale if you are
currently reviewing previous historical data. If the time scale is 24 Hours, a Next 24 Hours link is displayed.
If the time scale is 3 weeks, a Next 3 Weeks link is displayed. If you are viewing the current data, this link
is unavailable.
To display the next time scale of data:

NOTE: This example uses 24 hours as a time scale.

Above the graph, click the Next 24 Hours link. The graph is updated to display the next 24 hours of data
for the selected systems.

Configuring/Changing HP Power Regulator and Power Cap settings
The HP Power Regulator Configure section enables you to set the Power Cap and change the Power Regulator
mode of the selected systems.
To configure the HP Power Regulator mode or the Power Cap:
1. From the HP Insight Control power management page, open the Power Management Actions

section, select the systems to change and click Change. The Configure HP Insight Control power
management section appears.

2. Select one of the following modes from the Insight Power Manager Status list:

• HP Dynamic Power Savings Mode. Allows the system to dynamically change the processor
power level based on current operating conditions.

• HP Static Low Power Mode. Sets the processor to the lowest supported processor state and
maintains it at the lowest state.

• HP Static High Performance Mode. Sets the processor to the highest supported processor state
and maintains it at the highest state.

• OS Control Mode. Configures the system to support OS-based power management. The system
operates at the highest supported processor state until the OS-based power management is enabled.
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NOTE: Changing the HP Power Regulator mode may result in a small change in the system minimum
power draw. This will be detected the next time the system is reset, and will affect the minimum possible
power cap for a server or its containing enclosure. HP recommends the use of HP Dynamic Power
Savings mode.

3. Enter a Power Cap value in the text box.

• The type of power cap is determined when selecting:

A single system, the cap is a static single-system cap. If the system features the necessary
hardware and software to support Dynamic Power Capping, the tooltip on the cap value will

•

display "System supports Dynamic Power Capping." Otherwise, the system supports normal
Power Capping. Dynamic Power Capping is superior because it is capable of reacting to
power level increases fast enough to provide electrical circuit breaker protection. If the text
"System supports Dynamic Power Capping" is not displayed, the system supports normal
Power Capping. Normal power capping does not react fast enough to provide electrical
circuit breaker protection. Once a power cap is set, the average power reading of the system
over time should be at or under the cap value.

NOTE: For a single server, HP recommends that you not set the power cap to less than 20%
of the difference between maximum power and idle power. To do so may adversely affect
the stability of the operating system.

• Multiple systems, the cap is a static group cap. With a static group cap, each system in the
group is assigned a static linear apportionment of the total group cap.

NOTE: The Power Cap supported systems only will be considered for calculating the
Minimum Power, Maximum Power, Average Power, Maximum Available Power, and Power
Cap Lower Bound.

NOTE: If the group of systems contain both the Power Cap and Dynamic Power Cap
supported systems, the resulting Power Capping type while configuring systems as a single
group is Power Cap.

• An enclosure, the cap is a Enclosure Dynamic Power Cap. This type of cap dynamically sets
and adjusts caps on the individual systems in the enclosure to meet workload demand while
complying with the total enclosure cap.

NOTE: If you set individual system caps, and then apply an Enclosure Cap, and then turn
off the Enclosure Cap, the initial single system caps will not be restored.

NOTE: Enclosure Dynamic Power Caps are only set when an enclosure is selected. Selecting
all the blades in an enclosure results in a static group cap.

NOTE: Do not set a cap on an empty enclosure.

• The Power Cap value can be entered in Watts, Btu-hr, or a percentage of the difference between
the Minimum and Maximum Power.

• Minimum Power. This column reflects the measured idle power for the system in its current
configuration.

• Maximum Power.This column reflects the measured maximum power observed for the system
in its current configuration.

• Average Power.This column reflects the average power observed for the system in its current
configuration for the interval selected in the graph section.

• Maximum Available Power.This column reflects the maximum power available from the
system power supplies or the blade enclosure..

• Power Cap Lower Bound.This column reflects the power cap lower bound.

• The value entered should be between the Minimum Power and Maximum Available Power.
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• The closer the entered value is to the Minimum Power the more likely that your system(s) performance
will be impacted.

• With enclosures, you can set a Bay Cap Option for each bay in the enclosure to include or exclude
the bay from the Enclosure Dynamic Power Cap. You can select one of the following options:

• Opt-in. This allows the systems in the bay to participate in the cap.

• Opt-out. This exempts all the systems in the bay from the cap. You cannot exclude more than
1/4th of the available bays.

• Click the Refresh Bays to see the latest capabilities and power configurations of the currently
installed blades.

NOTE: Remove the check mark in the Power Cap column if you want to disable the currently configured
power cap.

NOTE: A tooltip indicates the type of power capping a system or enclosure can support. Systems or
enclosures that support Dynamic Power Capping are in addition denoted with an asterisk.

4. Click Next to continue the process of changing the HP Power Regulator state and the Power Cap
setting. You can click Cancel to discard your selection.

5. A summary of the changes to be made are shown. If you are configuring a Power Cap, the impact of
that change is analyzed and reported as one of three results.

• OK: This value should not significantly impact system performance.

• Caution: This value may impact system performance.

• Warning: This value will negatively impact system performance. Consider revising.

NOTE: The Enclosure Dynamic Power Capping and Alerts require Onboard Administrator v2.30,
Integrated Lights-Out 2 v1.70, and Power Micro v0.8.
For more information on HP Enclosure Dynamic Power Capping, see http://www.hp.com/go/
powercapping

6. Click the Confirm Change to continue and make the change. The progress and results of the change
will be displayed in the Status field. You may also click the Cancel or Previous buttons if you do not
want to make the change.

NOTE: See HP Power Regulator for ProLiant for more information on processor power states and when
each state is useful.

After making changes to HP Insight Control power management, a summary will be seen similar to the
image below:

The table shows the potential changes to tweak and experiment prior to making actual changes to nodes
on the network. The table lists both the current mode and set Power Cap value.
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When viewing the group portion of the table as seen in the image above, the Power Cap value (if supported)
is allocated only to the Power Cap supported systems.

NOTE: The cap is determined for each Power Cap supported system by converting numerical values
(nonpercentage) to a percentage and then calculating the actual numerical cap based on that information.
For example, when you select three systems and those systems reported a total maximum power of 1000
watts and an average power utilization of 700 watts. This number is converted to a percentage of maximum
power which is 80% and that value is used to set the cap on the individual nodes.

NOTE: You can configure the system power configuration as Systems Insight Manager task. This task can
be scheduled through Configure→Power Management→Power Usage Controls.... You can view the
results through Tasks & Logs→View Tasks Results.

Configuring and scheduling alerts
Requirements for receiving alerts

To receive alerts, perform the following:
1. Using iLO web interface, configure the CMS server to receive SNMP alerts from iLO 2.
2. Using power management interface, configure alerts for either Average Power Consumption or Peak

Power Consumption.
3. Using Systems Insight Manager Options→Events→SNMP Trap Settings page, configure

cpqHo2PowerThresholdTrap defined in cpqHost.mib as described below:
a. Select cpqHost.mib for the Mib Name field.
b. Select cpqHoPowerThresholdTrap for the Trap Name field.
c. Select Yes for the Enable Trap Handling field.
d. Click OK.
On successfully receiving alerts, you can view the alerts from the Events tab of the System page. To
view the details of the alert, click (SNMP) Power Threshold Exceeded(11018).

Configuring and scheduling alerts
Insight Control power management enables you to configure alerts when the power consumption for a single
system exceeds the set threshold value for a given interval of time. You can also schedule the alerts on targets
as Systems Insight Manager task, which can be either scheduled or run immediately.

NOTE: You can configure and schedule alerts only on the power management supported devices or
systems.

To configure and schedule alerts, perform the following:
1. Select the systems under the Systems tab.
2. Click Configure→Power Management→Power Alerts.... The Step 1: Verify Target Systems page

appears.
3. Click Next.

If all the targets are licensed to use power management, the Step 3: Configure/View Alerts page
appears.

4. Select an option for Warnings Triggered By field for the listed targets.
5. Enter appropriate values for Threshold and Duration (Minutes) fields.
6. Click Next to confirm the changes.
7. Click Run Now to run the task immediately or click Schedule to schedule a task. If you click Schedule,

the Step 5: Schedule Task page appears. On the Step 5: Schedule Task page, perform the following:
a. In the Task name field, enter a unique name for the task.
b. Under the When would you like this task to run? section, select one of the following options:

• Periodically Select from intervals of minutes, hours, days, weeks, or months. With periodic
scheduling, you can configure the task to run until a certain date and time or to execute only
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a set number of times. Periodic scheduling allows time filters to be applied. These filters specify
the hours of the day when a scheduled task can operate.

NOTE: If you want to schedule a task to run once a month on the 31st of the month and the
month has only 30 days, the task will run on the 1st day of the following month.

• Once Specify the date and time the task is to run.

• When new systems or events are added to the collection This option is only available if you
select a Collection of Systems or Events as your target. The task runs only when new
systems or events meet the collection criteria. You can also apply a time filter to this type of
scheduling.

• When systems or events are removed form the collection This option is almost identical to
the previous option, except that the task runs only when systems contained in the Collection
of Systems or Events no longer meet the collection criteria. A time filter can be applied to
this type of scheduling.

• Not Scheduled This option specifies that the task runs only when manually executed by a
user with appropriate privileges. This task never runs automatically. Tasks can be manually
run from the All Scheduled Tasks page or the CLI

c. Under In addition, select from the following options:

• Run when the central management server is started Select this option if you want the task
to run every time the CMS is started.

• Run now Select this option to run the task immediately after it is saved.

• Disable this task Select this option to temporarily disable the task. This task is shown as
Disabled on the All Scheduled Tasks page.

d. After you select a scheduling option, refine the schedule in the Refine schedule section. The
available options vary depending on the scheduling option selected in step 3.

e. Click Done. The All Scheduled Tasks page appears. Click Previous to return to the previous
page.

Downloading historical data in CSV format
Insight Control power management enables you to generate reports either immediately or by scheduling it
as a task and save the report as a CSV file on CMS.

NOTE: The filename of the CSV file uses 24-hour timestamp and is in the format MM_DD_YYYY_hh_mm.csv.

To export reports:
1. Select the systems/devices under the Systems tab.
2. Click Reports→Power Management→Export Report. The Insight Control power management

Report page appears to verify target systems.
3. Click Next.

If all the targets are licensed to use power management, the Step 3: Configure Reports page appears.

4. Under Report Name section, select one of the following:

• Create a dynamic filename based on timestamp. This option includes timestamp as the filename.

• Use this name and append timestamp. Specify a name to prefix before the timestamp for the
filename.

• Use this name (Caution: Existing file will be overwritten). Specify a name for the filename.
If a file already exists with the same name, then power management overwrites the already existing
file.

Downloading historical data in CSV format 39



5. Under Select data range, select one of the following:

• Most recent. Select a value from the list.

• Use this range. Select the date and time for the From and To fields.

6. Click Run Now to run the task immediately or click Schedule to schedule a task. If you click Schedule,
the Step 5: Schedule Task page appears. On the Step 5: Schedule Task page, perform the following:
a. In the Task name field, enter a unique name for the task.
b. Under the When would you like this task to run? section, select one of the following options:

• Periodically Select from intervals of minutes, hours, days, weeks, or months. With periodic
scheduling, you can configure the task to run until a certain date and time or to execute only
a set number of times. Periodic scheduling allows time filters to be applied. These filters specify
the hours of the day when a scheduled task can operate.

NOTE: If you want to schedule a task to run once a month on the 31st of the month and the
month has only 30 days, the task will run on the 1st day of the following month.

• Once Specify the date and time the task is to run.

• When new systems or events are added to the collection This option is only available if you
select a Collection of Systems or Events as your target. The task runs only when new
systems or events meet the collection criteria. You can also apply a time filter to this type of
scheduling.

• When systems or events are removed form the collection This option is almost identical to
the previous option, except that the task runs only when systems contained in the Collection
of Systems or Events no longer meet the collection criteria. A time filter can be applied to
this type of scheduling.

• Not Scheduled This option specifies that the task runs only when manually executed by a
user with appropriate privileges. This task never runs automatically. Tasks can be manually
run from the All Scheduled Tasks page or the CLI

c. Under In addition, select from the following options:

• Run when the central management server is started Select this option if you want the task
to run every time the CMS is started.

• Run now Select this option to run the task immediately after it is saved.

• Disable this task Select this option to temporarily disable the task. This task is shown as
Disabled on the All Scheduled Tasks page.

d. After you select a scheduling option, refine the schedule in the Refine schedule section. The
available options vary depending on the scheduling option selected in step 3.

e. Click Done. The All Scheduled Tasks page appears. Click Previous to return to the previous
page.

Opening the Data Center Power Control Rules page
To access the Data Center Power Control Rules page, perform one of the following:

• Select Options→Data Center Power Control Rules....

• Select Tools→Data Center Power Control and click Define Rules tab.

These options are available only to users who are authorized to access the Data Center Power Control Rules
tool. For information about granting authorization, see the HP Systems Insight Manager User Guide available
at http://h18013.www1.hp.com/products/servers/management/hpsim/infolibrary.html.

Defining and managing rules using Data Center Power Control
HP Insight Control power management enables you to define and manage rules that control system power
consumption.
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Using the Data Center Power Control Rules page, you can define, edit, delete, and simulate the execution
of rules. Each rule corresponds to a button on the Data Center Power Control page. Rules are organized
into groups. Each group corresponds to a boxed set of rule buttons on the Data Center Power Control page.
You can define groups to organize your rules however you wish: by purpose, by physical location, by
responsible organization, etc.,
Each rule has a description (which appears next to its button on the Data Center Power Control page), a list
of Systems Insight Manager users who are authorized to run that rule, and one or more steps that the rule
should perform. Each step consists of an action and a set of filters used to choose the systems to which that
action should be applied. These filters can choose systems based on Systems Insight Manager collection
membership, device type, operating system, power source, physical location, and many other criteria.

Adding/Editing/Deleting a group
To add a group, perform the following:
1. From the Data Center Power Control Rules page, select the group after which you want to add a group

and click New Group. The New Group section appears at the bottom of the Data Center Power Control
Rules page.

2. Enter a name in the Group Name field.
3. Click Save to save and include the new group name. Or, click Cancel to discard the changes.

The new group name will be listed in the Rule List table immediately, after the group that was selected,
when you click New Group.

To edit a group, perform the following:
1. From the Data Center Power Control Rules page, select the group that you want to edit from the Rule

List table and click Edit. The Edit Group section appears at the bottom of the Data Center Power
Control Rules page.

2. Modify the name in the Group Name field.
3. Click Save to save the modified group name. Or, click Cancel to discard the changes.
To delete a group, perform the following:
1. From the Data Center Power Control Rules page, select the group and click Delete.
2. In the Delete Confirmation dialog that appears, click Yes. This will delete the group and all of the rules

within it from the Rule List table.

Adding/Editing/Deleting a rule
A rule can have one or more steps in it. Each step has an action that is applied to a set of target systems.
The target systems are chosen at the time the rule is invoked, based on the filters in the rule step definition.
The supported actions are shut down, power level, power switch, run script, and pause. Rules may be marked
Ready to Use; if not, their buttons will not appear on the Data Center Power Control page. (HP's pre-defined
rules are not initially marked Ready to Use, as a reminder that they must be customized for the local business
needs.)
To add a rule to a group, perform the following:
1. From the Data Center Power Control Rules page, select the group that should contain the new rule or

the rule after which you want to add the new group.
2. Click New Rule. The New Rule section appears at the bottom of the Data Center Power Control Rules

page.
3. (Required) Enter the rule name in the Rule Name field. This will enable the New Step button to include

some actions.
4. Clear the Ready for Use field if the rule is not yet ready for use. By default, the rules are considered

as Ready for Use. If Ready for Use is not selected, the rules button will not appear on the Data Center
Power Control page.

5. Enter the description for the new rule in the Description field. This description will be listed on the Data
Center Power Control page next to the button for the rule.

6. Add user permission to a rule. To add user permission to a rule, see Adding/Deleting user permissions.
By default, a rule can only be run by users with rule editing privileges.
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7. Click New Step to add a new step with action for the rule. The New step section appears at the bottom
of the New Rule section of the Power Control Rules page.

8. Select an action for the Action field. Options are:

• Shut down: Select this option to shut down the target systems. It logs into each target system
through SSH and issues the appropriate shutdown command for the operating system in use on
that system. Systems Insight Manager must be configured with login credentials to the target systems.
This action is valid for systems running Windows, HP-UX or Linux. The systems must have an Insight
Power Manager license.

• Power level Select this option to set the power regulator state in the Integrated Lights Out (iLO)
management processor for a system. This action is valid for systems with an iLO management
processor and an Insight Control power management license.

• Power switch Select this option to turn the power for a system on or off. This action is valid for
systems with an iLO management processor and an Insight Control power management license.

• Run script Select this to run a user-supplied program (usually a script) on the CMS. The script is
called once for each target system, with the system name passed as a command line argument.
The script runs with full administrator/root permissions. Insight Control power management licenses
are required for targets which are servers and licenses are not required for non-server targets.

• Pause Select this option to insert a delay between rule steps.

9. Based on the action selected in the above step, the parameters of the actions appear as:
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Table 3-2 Action

OptionsParameterFor Action

• Graceful: Select this to cleanly shut
down applications on the system before
the system shuts down. This takes more
time and is used in normal circumstances.

• Forced: Select this to shut down the
system immediately. This allows the OS
to shut down cleanly (e.g. flushing disk
buffers). But, applications may not get
the opportunity to shut down cleanly. You
can use this method when quick
shutdown is essential.

NOTE: The forced shut down option on
HP-UX and Linux systems does the graceful
shut down on those systems.
On VMware ESX 3.i and 4.i series
(embedded) versions, you will be unable to
shutdown the hosts and guests either
gracefully or forced as these versions do not
have the SSH capability.

MethodShut down

• dynamic power mode: Select this
option for the iLO to vary the power
consumption of the system dynamically
based on the load.

• OS-controlled power mode Select this
option for the system operating system
to vary the power consumption
dynamically based on the load.

NOTE: ProLiant systems require a
reboot to enter or exit OS-controlled
power mode. On such systems, the
power mode change will be held until
the next reboot occurs. This action does
not force a reboot.

• high power mode Select this option to
set the system power consumption at the
highest level to provide best
performance.

• low power mode Select this option to
set the system power consumption at a
low level that sacrifices performance for
power reduction.

Power levelPower level

• turn power off Select this option to turn
the system power off.

• turn power on Select this option to turn
the system power on.

Switch settingPower switch

Enter the command line to execute the script.
The target system names will be added to
the end of this command line before it is run.

NOTE: To run a script on a Windows
CMS, it may be necessary to use a
command line that starts with "cmd.exe /C"
followed by the script name. If the pathname
of the script contains spaces or special
characters, remember to use the quotes. If
the script is a visual script or shell script, use
script with the intepreter name. For example,
"cmd.exe /c cscript <visual script name> "
in Window CMS or "ksh < script name> "
in Linux/UNIX.

Command lineRun script

Enter the time in seconds.DelayPause
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10. Add one or more filters for the Act on systems field. The filters information is detailed as:
Table 3-3 Act on systems

DescriptionFilters

Selects systems that belong to a specified Systems Insight Manager
collection. Collections can be defined and edited using the
Customize link on the left side of the Systems Insight Manager
window.

collection

Selects systems in the specified data center. This is set on the
system page for each rack, and is inherited by all systems in the
rack.

data center

Selects systems in the specified row of the data center. This is set
on the system page for each rack, and is inherited by all systems
in the rack.

data center row

Selects systems in the specified blade enclosure. This is
automatically discovered.enclosure

Selects systems that have the specified overall health status, as
computed by Systems Insight Manager from a variety of sources.hardware status

Selects systems that have the specified IP address. This is
automatically discovered.ip address

Selects systems running the specified operating system. This is
automatically discovered.operating system

Selects systems in the specified position in their row of the data
center. This is set on the system page for each rack, and is
inherited by all systems in the rack.

position in row

Selects systems that are directly or indirectly powered by the
specified circuit. This is set on the system page for each rack, or
may be automatically discovered.

power source

Selects systems that have the specified product (model) name. This
is automatically discovered.product name

Selects systems in the specified rack. This is set on the system page
for each rack, or may be automatically discovered.rack

Selects systems with the specified server role. This is set using the
Options > System Properties menu item in Systems Insight
Manager.

server role

Selects systems with the specified name. This is automatically
discovered.system name

Selects systems with the specified sub-type. This is automatically
discovered.system sub-type

Selects systems with the specified type. This is automatically
discovered.system type

Selects virtual machines hosted by the specified virtual machine
host. This is automatically discovered.virtual machine host

You can click Add to add more filters. To delete a filter, click Delete that is available near a filter.

11. Click Save Step to save the step for the rule. Or, click Cancel to discard the changes. The new step
appears in the Steps table of the New Rule section of the Power Control Rules page.

NOTE: To edit a step, select the step in the Steps table, click Edit Step and follow the steps 6-9 as
mentioned above.

NOTE: To delete a step, select the step in the Steps table, click Delete Step. In the dialog box that
appears, click Yes.

12. To add more steps, click New Step again and follow the above procedure.
13. Click Save Rule to save the rule. Or, click Cancel to cancel the new rule.

The new group name will be listed in the Rule List table immediately, after the group that was selected,
when you click New Group.
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To edit a rule, perform the following:
1. From the Data Center Power Control Rules page, select a rule within a group and click Edit. The Edit

Rule section appears at the bottom of the Data Center Power Control Rules page.
2. Follow the steps 2-11 as mentioned in adding a rule procedure.
To delete a rule, perform the following:
1. From the Data Center Power Control Rules page, select a rule within a group and click Delete.
2. In the Delete Confirmation dialog that appears, click Yes. This will delete the rule of group from the

Rule List table.
Adding/Deleting user permissions

Adding/Deleting user permissions
In the Permissions area of the Data Center Power Control Rules page, you can specify a list of users explicitly
authorized to run a rule. This is in addition to Systems Insight Manager “full rights” users, and all users
authorized to use the Data Center Power Control Rules page, who can run any rule regardless of whether
they are on the permissions list for that rule. If a user has permission to run a rule, that rule will perform all
of its specified actions on all of its specified targets, even if the user lacks authorization to take the same
actions manually through Systems Insight Manager tools.
The permission section contains two columns: Users with explicit permission to run the rule and Other users.
By default, Users with explicit permission to run the rule is empty and Other users lists the users of Systems
Insight Manager. For more information on adding new users, see the HP Systems Insight Manager User
Guide available at http://h18013.www1.hp.com/products/servers/management/hpsim/infolibrary.html.
To add user permission for a rule, perform the following:
1. From the New Rule or Edit Rule section of the Data Center Power Control Rules page, click Permissions.

The Permissions section appears at the bottom of the New Rule or Edit Rule section of the Data Center
Power Control Rules page.

2. Select a user’s name from the Other users column and click to move it into the Users with explicit
permission to run the rule column to add permission to the user for this rule. You can also include
permission for more than one user for a rule.

3. Click Save Permissions to save the changes. Or, click Cancel to discard the changes.
To delete user permission for a rule, perform the following:
1. From the New Rule or Edit Rule section of the Data Center Power Control Rules page, click Permissions.

The Permissions section appears at the bottom of the New Rule or Edit Rule section of the Data Center
Power Control Rules page.

2. Select a user’s name from the Users with explicit permission to run the rule column and click
to move it into the Other users column to delete permission for an user.

NOTE: If a user has Systems Insight Manager authorization to use the Data Center Power Control
Rules page to define and manage rules, that user will be able to run any rule regardless of the settings
on the Permissions page.

3. Click Save Permissions to save the changes. Or, click Cancel to discard the changes.

Copying a rule
To copy a rule, from the Data Center Power Control Rules page, select a rule within a group and click Copy.
Select the group that should contain the copy, and the name for the copied rule, and click Save. This will
create a copy of the rule, in the specified group, with the specified name.

Reordering the group or rule
To rearrange the order of the groups or rules within the groups in the Rule List table, perform the following:

1. Select the group or rule within a group and click or buttons to move the rule or group to the
desired order.

2. Click Save Order to save the changes.
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Simulating the rule
You can simulate a rule to validate all the information and check licensing and connectivity to all the target
systems without actually changing the power usage of the target systems.
To simulate a rule, perform the following:
1. From the Data Center Power Control Rules page, select a rule within a group and click Simulate. The

Systems Insight Manager View Task Results page appears.
2. You can monitor the progress of the simulation of the rule in the Systems Insight Manager View Task

Results page. For more information, see Viewing rule simulation/execution results.

Stopping a Running Rule
You can stop a running rule from either the Data Center Power Control page or the View Task Results page.
From the Data Center Power Control page, click the Stop button next to the rule you want to stop. From the
View Task Results page, select the task instance for the rule you want to stop and click the Stop button.

Viewing rule simulation/execution results
HP Insight Control power management enables you to execute the rules for controlling the power of the data
center using the Data Center Power Control page. To reach the Data Center Power Control page, select
Tools→Data Center Power Control or click Invoke Rules tab from the Data Center Power Control Rules
page. In the Data Center Power Control page, the rules that are defined in the Data Center Power Control
Rules page are listed as buttons to execute the rules. The Data Center Power Control page shows buttons
only for those rules that its current user is authorized to run. The description of each rule is also listed here
next to the rule buttons to describe the exact function of the rule.

HP Pre-Defined Rules
When the Data Center Power Control facility is first installed, it comes with a set of pre-defined rules that
can serve as examples. These rules do not have Ready to Use selected, so the pre-defined rules do not
have buttons on the Data Center Power Control page. But, the pre-defined rules can be seen on the Define
Rules tab.
To use one of these pre-defined rules, make a copy of the rule, then edit the copy so that it is appropriate
for the installation. Or, alternatively, edit the pre-defined rule itself to customize it for the installation, and
then select the corresponding Ready to Use box.

Using Data Center Power Control page
Click on any of the rule button to execute that particular rule. The Rule Preview page appears displaying
the actions and targeted systems defined for that rule to confirm the execution of that rule. Click Run Now
to execute the rule. The Systems Insight Manager View Task Results page appears displaying the progress
of the execution of the rule. If you click Cancel in the Rule Preview page, you will be returned to the Data
Center Power Control page.

Viewing rule simulation/execution results
To view the task results, perform the following:
1. From the menu, select Tasks and Logs→View Task Results.
2. Select a task.
The Task Results page displays a list of task instances created by all tasks.

Viewing task instance results
From the Task Results page, select a task instance by selecting a row from the Task Instances list.
The Task Instance list displays the following information:

• Status This field displays the status of the task.

• ID This field displays the task job ID number.
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• Task Name This field displays the name of the task that was executed.

• Tool This field displays the name of the tool that was used.

• Owner This field displays the user name that currently owns the task.

• Command This field displays the command used to run the task.

• Summary Status This field displays the summary status and indicates the status of some tasks.

• Target This field displays the name of the target collection or individual systems where the task
executed. If you run a custom tool or a MSA tool, this field displays the CMS system name. With MSA
commands, the command resides on the CMS and runs from the CMS for a remote system or list of
systems. Therefore, the target for this type of command always shows as the CMS.

• Executed As This field displays the user context where the tools were executed from.

• Start Time This field displays the time when the task was started.

• End Time This field displays the time when the task was completed or cancelled.

• Duration This field displays the amount of time it took to run the task.

NOTE: The list of task instances is based on user privileges and access levels. Users with administrative
rights can view all task instances known to the system.

Viewing target details

NOTE: This section appears for SSA tools only.

Target details include the following:

• Target Name This field displays the name of the target.

• Status This field displays the status of the target.

• Exit Code This field represents the success or failure of an executable program. Typically, if the return
value is zero or positive, the executable ran successfully. If a negative value is returned, the executable
failed.

• The Stdout tab This tab displays the output text information.

• The Stderr tab This tab displays information if the executable experienced an error.
This tab does not appear for discovery task results.

• Files Copied tab This tab displays what files are in the process of being copied or have been copied
to the target system. This tab is not present for tools that do not perform any file copies to their target
systems.

To view target details:
Procedure 3-33 View target details
1. From the Task Instance Results section, select a target system from the table below the Summary

Status.
A window appears.

2. View the target details.

Enabling system shutdown through Data Center Power Control
Data Center Power Control requires all managed nodes to be configured with Secure Shell (SSH) prior to
running a rule as SSH is required for obtaining secure access to the managed nodes.
To configure SSH using Insight managed system setup wizard, perform the following:
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1. From HP Systems Insight Manager console, select Configure→Managed System Setup Wizard.
2. Select the target servers to configure and click Apply. The Verify Target Systems page appears.
3. Click Run Now. The Introduction step page appears.
4. Click Next. The Select Features step page appears.
5. Expand HP Systems Insight Manager, select Remote Command Execution, and click Next. The

Choose Options step page appears.
6. Enter the user name for SSH as Administrator or root depending upon the target node. Then,

enter the SSH authentication option as user-based or host-based. The secured SSH authentication option
is user-based. Click Next. The Analyze System step page appears displaying the progress of analyzing
the nodes.

7. Remove the failed nodes and click Next for the nodes that displays the Configuration occurs message.
The Select Licenses step page appears.

8. Add the license details for the nodes, if required, and click Next. The Task Credentials step page
appears.

9. Enter credentials for all the systems listed and click Next. The Summary step page appears with the
summary of actions.

10. Click Run Now to configure the target nodes. The Results page appears displaying the configuration
on target nodes. If SSH is not installed on managed nodes, then at configuration, the Critical Resource
Analysis (CRA) tool is invoked for installing SSH on the nodes.

Accessing power management using web services interface
Insight Control power management provides access to power control data, power history, power topology,
and physical topology data through the Power Management Web Service interface using the SOAP protocol.
You can download the Web Services Description Language (WSDL) definition of the interface from the
Systems Insight Manager CMS at the following URL using your Systems Insight Manager host IP address:
https://{hpsimhost}:50001/mxsoap/services/HpIpmApi3_0_1?wsdl
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4 Managing power and cooling facilities in your data center
Task: Importing power configuration from external databases

HP Insight Control power management collects power utilization and capacity data from systems and devices
in a data center and allows an administrator to set a cap on the utilization. Before power management starts
monitoring or managing power consumption of systems and devices, it requires information on the physical
topology of systems and devices, and the power topology of the power delivery devices connected in a
data center. The power configuration information is available in the CMS database and you can import this
information available in text formats or Microsoft Excel worksheets using the available power management
CLI commands.

Importing from Excel worksheets
In Excel worksheets, the data is normally available in visual layout (VIS) and tabular (TAB) formats. For
example, the data in an Excel worksheet is shown below:

For a small data center, the data can be maintained manually in VIS format where a column in the Excel
worksheet represents a rack and each cell is a slot position for a system. The VIS format is limited to only
the physical hierarchy of the systems and devices in a data center. To convert data in the VIS format to text
format, you can follow the instructions included in the ipmvis2txt(1M) man page.
For a larger data center, the data is normally maintained in the TAB format because of the volume of the
systems and devices. The TAB format includes both the physical hierarchy and power hierarchy supporting
additional complex information. The Excel worksheets in TAB format often begin with output from other
software vendors, even if they are maintained manually over the long term.
To import data from the TAB format into power management, perform the following:
1. Collect the required physical device descriptions for racks and rack devices in an XLS file. For example,

bnb2ipm.xls.
2. Collect the required power device descriptions for PDRs, PDUs, Breaker Panels, Branch Circuits, and

Rack PDUs.
3. Collect the powered by associations information between power strips and breakers.
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4. Verify the bnb2ipm.xls file for any errors, duplication of entries, or missing information using the
command:
ipmtab2txt bnb2ipm.xls > /dev/null

For information on ipmtab2txt command, see ipmtab2txt(1M).
After verification, create a new text file with the results from the this step. For example, name the file as
bnb.txt.

5. From the command line utility, log-in into power management and import the bnb.txt text file into power
management using the command:
ipmimport bnb.txt

For information on ipmimport command, see ipmimport(1M).

For more information on this task and information on importing data from text formats, see the Importing
existing data center configuration data into power management white paper available at http://www.hp.com/
go/insightcontrol/docs.

Task: Monitoring the power and cooling requirements of your IT equipment
With Insight Control power management, you can optimize the power and cooling requirements of your
data center efficiently. While each individual system, enclosure, PDU, or PDR in your data center can provide
its power requirements and sometimes even a limited amount of power consumption history, it is still difficult
to understand the power and cooling requirements for your data center in a holistic way. This section guides
you through the steps of configuring power management to provide you that holistic view, and help you
understand and control your power and cooling requirements.

Step 1: Identifying/Discovering your IT systems
HP Systems Insight Manager provides a discovery mechanism to find all networked IT systems on your local
network. This software can identify, classify, and communicate with a wide variety of systems such as servers,
enclosures, management processors, power distribution units, power distribution racks, and uninterruptible
power systems (UPS) – from HP as well as systems from other manufacturers.
For more information on the setup and discovery process, see HP Systems Insight Manager documentation
at http://h18002.www1.hp.com/products/servers/management/hpsim/infolibrary.html.
To successfully obtain the complete information of the systems through Systems Insight Manager, perform
the following:
1. Provide sign-in credentials for each system configured in Systems Insight Manager either through Global

Credentials, or by specifying credentials for individual systems using the Options→Discovery
configuration.

2. Apply Insight Control license on each of the HP ProLiant systems to enable power management. For HP
Integrity systems, you need not apply any license as the systems are licensed per-core. For more
information on licensing systems, see Licensing power management systems.

3. Setup all systems to be discovered by Systems Insight Manager or use the already available power
configuration data using the import facility.

After you have completed identification and discovery of your IT systems and power management has
collected configuration data for your systems, you can start investigating more about the overall systems in
your data center.

Step 2: Understanding the operational range of individual IT systems
After identifying the systems and running initial discovery and data collection steps, you can utilize the
Power/Thermal Analysis views page to get a quick and high-level view of power management properties
of the system. For detailed Power/Thermal data report of a given system, click on the Power Summary Meter
of that system. For a quick description of the operational range of power for the equipment (minimum power
to calibrated max power), see Power Summary meter.
As you have viewed the power capabilities and consumption details of a system, you can also view the
aggregated values of power capabilities and consumption details for entire racks or areas of your data
center floor by performing the tasks mentioned in the following steps.
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Step 3: Finding thermal hot-spots in your data center
Insight Control power management provides detailed monitoring data, which you can use in different ways
to determine the power and cooling capabilities of the devices in your data center. While the overall cooling
in your data center may be sufficient, there may be areas that are insufficiently cooled due to various reason
such as poor airflow, concentration of excessive heat output, or wrap-around airflow at the ends of aisles.
One convenient way to investigate such issues is by a visualization of the temperature in different areas of
your data center. To accomplish this, you need to first describe the physical positions of your systems. Power
Management enables you to create Power/Layout diagrams for systems placed in racks and racks placed
in rows of a data center (or portion of a data center).
To generate your data center Power/Layout views, perform the following:
1. Specify the position of each system or enclosure in a rack.

a. If you maintain a database (for example, UCMDB or Excel worksheet) describing the grouping of
systems into racks and racks into a grid in a data center, you can import it directly into power
management. For more information on importing information into power management, see Task:
Importing power configuration from external databases.

b. HP BladeSystem enclosures automatically creates an enclosing rack in Systems Insight Manager
during the discovery process completed earlier, based upon the name configured in the HP
BladeSystem Onboard Administrator. If there is a mixture of enclosures and other devices in the
rack, add the rack-mount systems and other devices into the rack as described in Defining a rack.

c. For other racks that cannot be discovered, create a new rack to group all devices together using
Defining a rack.

2. If your facility has a policy to set the total thermal output for individual racks, you can specify the Thermal
Limit (Watts) value in the Edit Rack page. Or else, you can leave this value blank.

3. After configuring all the racks, place them in the data center.
• Create a new data center object to represent the area of interest. Typically, this would be your

entire data center floor as described in Defining a data center.

After you have configured racks and data centers, it takes 24 hours to provide the aggregated thermal
information. To view thermal information before 24 hours, click Refresh Data on the Power/Thermal tab
of a rack.
You can then view the peak observed temperature in each area of your data center over 24 hours. You can
view this information by clicking on the meter for the Data Center from the Power/Thermal Analysis views
page, or through the Power/Thermal tab of the data center in Systems Insight Manager. You can access the
Power/Thermal tab from any of the Systems Insight Manager screens by clicking on the hyperlink name of
the data center.
If you have configured any thermal limits for your racks, you can immediately see any potential violations
of these limits from the Power/Thermal Analysis View on the Physical Location tab. Also, click on “All Data
Centers” from the System and Event Collections, the Power Status column in the Power/Thermal Analysis
views page will highlight any racks that may potentially exceed their thermal limits. If any of the racks exceeds
the set thermal output limit, you must take corrective action. For more information on resolving such issues,
see Task: Protecting your power and cooling infrastructure.

Step 4: Finding available capacity on power delivery devices
To find the additional capacity or potential problems on power delivery devices such as PDUs and Branch
Circuits, you need to configure the power delivery hierarchy. For more information on power delivery
hierarchy, see Power delivery hierarchy.
To describe your power delivery hierarchy, perform the following:
1. If you are using a database (for example, UCMDB) that contains a representation of your power delivery

infrastructure, you can import the power configuration. For more information on importing power
configuration data, see Task: Importing power configuration from external databases.

2. If you do not have any such configuration that can be imported, you must manually configure the devices
to configure power management to understand the power delivery infrastructure that is providing power
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to your IT systems. For information on manually configuring the devices, see Describing Power Delivery
Hierarchy.

3. After completing the initial configuration, you must verify the data for consistency. From the
Power/Thermal Analysis view page, view the details in the Power Delivery tab to ensure no warnings
or errors are reported. In particular, note "Configuration Incomplete" warnings that highlight missing
configuration data, and "Configuration Error" notices that indicate that the current configuration is not
consistent with the underlying data collected by power management.

After completing these steps, you can identify the available capacity either directly through the Power
Summary Meters in the Power/Thermal Analysis view as described in Understanding the Power/Thermal
Analysis view or the sorted tables as described in Finding available capacity in racks and power delivery
devices.

Task: Ensuring the sufficient availability of power and cooling for your
data center

After configuring systems and devices in the data center, use the Power/Thermal Analysis page to view
diagnostic information on the power and cooling infrastructure.
In the Power/Thermal Analysis views page,

• Power Status Alerts are highlighted with severity icons to highlight the severity of the alert. Alerts for
contained devices are aggregated to the top-level object displayed.

• Potential overloads are highlighted on the Physical Location tab for exceeded thermal limits and on the
Power Delivery tab for power delivery devices.

For thermal overloads, you may consider the need to move one or more systems to a rack with more cooling
capacity, or by setting an upper limit on power consumption through use of power capping. For more
information, see Task: Protecting your power and cooling infrastructure.
Potential overloads on power delivery devices must be evaluated with care as they may represent the potential
of a tripped circuit breaker and unexpected system down time under the right conditions. Similar to thermal
overloads, you may need to reconfigure systems to receive power from other power delivery devices to
ensure sufficient capacity for all potential demands. Another option is to protect the power delivery
infrastructure by limiting power consumption using power capping. For more information, see Task: Protecting
your power and cooling infrastructure.

Task: Protecting your power and cooling infrastructure
In your data center, after configuring systems and devices, you must finalize the power and cooling
infrastructure. Planning this infrastructure protects your systems and ensures that there is no data loss because
of power problems. By planning this infrastructure, you are notified when systems are reaching their thresholds
of power or cooling limits.
After you have identified a portion of your power and cooling infrastructure that has a potential for an
overload, you did not experience any problem. But, power management analyses indicate that under a
worst-case scenario, your rack may exceed thermal output limits. Or, even still worse a circuit breaker on a
power delivery device may have the potential to trip resulting in loss of power if all equipment drew maximum
power at the same time. The traditional solution to this problem would either be to relocate systems to areas
of the data center with excess power or cooling capacity to avoid the potential problem, but this solution is
disruptive and requires significant planning. If your systems support HP Dynamic Power Capping, you can
reduce the maximum power consumption and eliminate the potential overload condition by specifying a
power cap value.
To protect your power/cooling infrastructure, perform the following:
1. Make a note of the maximum available power for the set of systems (the rack or the overloaded power

delivery device). This value must be reported in the "Potential Overload Analysis" message.
2. Select each system involved individually or press and hold the Shift key to select and add multiple

systems to the selection and click Display Power/Thermal data from the Quick Launch menu.
3. In the Verify Target Systems step page, the unsupported systems are removed from the selection.

Make a note of the unsupported systems to add their maximum power consumption and subtract the
value from the total power being allocated as mentioned in step 1. Click Next and confirm that some
targets will be removed from the selection.
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4. You will now analyze the power requirements for the combination of systems selected based on power
consumption history. It is a best practice that you have enough power history to identify any potential
cyclic peaks (such as end-of-month billing, or perhaps seasonal events).
a. Choose the desired time frame, for example 1 year, and click Draw Graph.
b. In the table that appears below the graph, determine the maximum power consumption for the set

of systems as noted in the Group Peak Power Consumption.
5. Compare the Group Peak Power Consumption value with the available power calculated in as

mentioned in step 3. Click Change in the Power Management Actions section and consider the following
issues to determine if it is reasonable to power cap this group to the Available Power:
a. The available power must be 10-20% above the Group Peak Power Consumption to ensure

that there is sufficient cap headroom to enable future growth.
b. The sum of Maximum Power for each system must be less than the Available Power.

6. If validation of the cap in step 5 indicates that it is reasonable, apply a power cap value for Available
Power to the group. Insight Control power management automatically distributes the power cap value
across the selection as a group, or you can divide the power cap value manually to distribute the power
to match the business value of each system. Since the set power cap value does not change between
or for the selected systems, you may wish to allocate a greater share of the cap headroom to production
systems, and lesser cap headroom to test systems.

Task: Getting notified of unexpected or excessive power consumption
You can configure to receive notification if the power consumption of a system exceeds a specified limit.
For information on configuring alerts, see Configuring and scheduling alerts.A limit is specified in terms of
a power threshold (a number in watts), a duration (a multiple of five minutes), and a type which can be
either average or peak power consumption. If the type of power consumption exceeds the specified threshold
for the specified number of minutes, then the system generates an alert.
The alert is generated as an SNMP trap in the management processor of the system. If the management
processor is configured to send traps to a Systems Insight Manager CMS instance, power management
presents the traps as Systems Insight Manager events associated with the correct system. You may then use
Systems Insight Manager Automatic Event Handling to route the event to the destination of your choice
such as page, e-,ail, custom CMS tool, SNMP trap, or system log.
Following is an example of how a power threshold exceeded event is presented in Systems Insight Manager:

Power consumption alerts are available on ProLiant servers that support power management with iLO2
firmware version 1.70 or later. You must check the availability of the required firmware version before
proceeding.
You can configure alerts using Configure→Power Management→Configure Alerts.... You can choose
either immediate execution of the alert configuration or schedule the alert execution for a later time or date.
You also view and edit the alert settings from the Display Power/Thermal data report and from the Power
Management Actions section of the Power/Thermal tab for a supported system. To decide the level of alert
and set the power alert threshold, it is recommended that you consult the power usage history in either of
these reports.
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Task: Validating delivery of redundant power to systems
After configuring the systems and devices, the Power Delivery tab in the Power/Thermal Analysis views page
provides diagnostic information about power delivery redundancy to the devices on each power delivery
device. By default, power management assumes that all devices must be configured for redundant power
delivery, and displays a "Redundancy Error" message for any system for which there is no independent Side
A & Side B power delivery. This includes identification of PDUs or Branch Circuits that are powered by a
common power delivery ancestor.
If a particular system does not support redundant power inputs or if redundant power is not required, you
can disable the "Redundancy Error" message by clearing the System requires redundant power option
in the System Properties of the system or device.
If a system does not have redundant power properly configured, it requires changing the physical power
delivery hierarchy to your systems to correct the problem. After correcting the hierarchy, you must update
power management with the changed configuration to eliminate Redundancy Error messages.

Task: Determining trapped capacity in your data center
When you want to deploy an additional system or enclosure in your data center, you determine that there
is insufficient power or thermal capacity for any new additions when using traditional methods of estimating
power requirements. Using the techniques in Task: Monitoring the power and cooling requirements of your
IT equipment, you may have discovered that the actual power requirements as reported by the equipment
based upon your current hardware configuration is significantly lesser than estimates based upon faceplate
ratings, or even based on the HP Power Calculator. After describing segments of your data center in the
Define Data Center page, you may have discovered additional capacity Step 4: Finding available capacity
on power delivery devices . If after performing such analysis which includes the calibrated maximum power
of each device, you still do not have sufficient capacity to deploy a new system, you can consider using HP
Dynamic Power Capping to reclaim additional capacity.
As you have observed in Task: Protecting your power and cooling infrastructure, power caps can be applied
to recover from errors in power and cooling configuration, but the same techniques can be applied to reclaim
under-utilized capacity. The key to successfully reclaiming power/thermal capacity of your data center is to
apply power caps, which does not affect the performance of the systems. You can apply HP Dynamic Power
Capping from a minimum to maximum power cap value. As long as the aggregate power consumption of
the systems does not approach the specified power cap, your application will have little or no impact on
performance.
For example, consider the Power Summary Meter of a HP BladeSystem enclosure as shown below:

While the enclosure may theoretically consume 35A of power (the Calibrated Max Power based upon the
current configuration of the hardware), the maximum power observed since power management monitoring
commenced was only 14A (Peak Observed Power). The difference of Calibrated Max Power and Peak
Observed Power, 35A-14A = 21A, represents the potential power that can be reclaimed when applying
the power cap value. Power caps are supported on both BladeSystem enclosures and many models of HP
ProLiant servers. Using a Dynamic Power Cap value prevents the capped device from using more than the
specified amount of power – even if it involves reducing the performance of the system.
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Various HP ProLiant servers support power capping (which limits the thermal output), and Dynamic Power
Capping (which limits the electrical power consumption). If you are attempting to reclaim thermal capacity,
or limit the total heat output of a group of systems, then either type of cap may be used. If, however, you
are attempting to prevent an electrical overload, be sure that your device supports dynamic power capping.
Similarly, for example, consider a system say ProLiant ML370 server as shown below:

While the faceplate power is 1000 Watts, the Calibrated Max Power as measured by the hardware itself
is only 509 Watts, and based upon historical observation of several months, the highest power consumption
ever observed was 432 Watts. Based on past behavior, there is 502-432 or 70 Watts that can potentially
be reclaimed without noticeably impacting the performance of the system.
When determining an appropriate cap to reclaim capacity, consider the following issues:
1. Do I have sufficient power history collected for this system to make reasonable projections for future

behavior? Several months of power history will likely ensure that you are seeing a typical depiction.
However, if your computing demand has a seasonal component (such as the holidays, tax season, or
end of the fiscal year spikes), you may want to analyze power history covering such time periods, or
allot additional headroom to avoid potential performance impacts of the cap.

2. Applying a Dynamic Power Cap value allows sharing of the cap value dynamically from systems that
are idle to systems that are experiencing demand. But, a cap value applied to a single system does not
adjust automatically, so it is important to ensure that there is sufficient headroom to avoid bumping into
the cap when there is more demand in the future.

3. When considering the requirements for the future, what is the trend of my CPU utilization and therefore
power consumption and thermal output? Are my workloads relatively stabile over time, or is there a
growing need for additional CPU? These factors dictate how much headroom you must leave to avoid
unnecessarily restricting performance.

4. Do I anticipate adding additional hardware (systems in an enclosure or memory, disks, or add-in cards
to a system)? Such additions will increase the upper end of the operating range of the equipment.

5. Consider the business importance of the performance of an individual system before apply any cap
that is significantly below the Calibrated Max Power. If the response time of the system is critically
important, you must apply caps to other systems and ensure that your critical systems always have
access to the absolute highest performance they can deliver.

Task: Reclaiming power/thermal capacity for a new system
As you deploy the new system in your data center, you must select a location that has following sufficient
resources:

• Physical space in a rack to mount the system

• Power delivery capacity to plug it into

• Thermal capacity, or sufficient cooling, to avoid overheating it and surrounding systems

• Network connectivity of the proper type and bandwidth

• Location with other related systems and other organizational issues
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If the power requirements for the system slightly exceed the power or thermal capacity within the chosen
rack, you can configure power capping to this system and others in the rack to ensure all get the necessary
resources, without wasted allocation. If you are deploying a system, you apply the cap value to the enclosure
that will include the system to ensure the power capacity of the power delivery devices and thermal capacity
of the rack are not exceeded. Then, insert the system in the enclosure. The cap value is divided among the
other systems in the enclosure. If it is not a system, you must determine the number of watts required by the
new system. You can use the HP Power Calculator, or more accurately start the system and determine its
Calibrated Max Power. You can obtain this value from the Power/Thermal Analysis views or Power/Thermal
data report pages of power management. You can also obtain the value from the Power Management
Settings page of the system’s iLO page, where it is mentioned as Sever Maximum Power, as shown below:

Then, determine the amount of power must be reclaimed to make the necessary power/thermal capacity
available in the rack.
When applying caps, use the following guidelines:
1. As the power demand varies, Enclosure Dynamic Power Capping can share caps between systems, it

is the first place to investigate when capping and there is typically significant capacity that can be
reclaimed by applying caps to enclosures.

2. If you have multiple enclosures, reclaim similar percentages of capacity of the headroom from each
enclosure instead of a large amount of headroom from a single enclosure.

3. When applying power cap value to individual systems, you need to be careful not to impact their
performance because of increase in load beyond the historically observed loads result in reduced
performance. Again, reclaiming a small percentage of capacity from multiple systems is preferable and
less likely to have a significant impact on performance.

4. When reclaiming power delivery capacity, you must ensure not to remove or increase power cap values
without proper planning as it could lead to overload of the circuit capacity.

Task: Classifying systems by business criticality
Based on business criticality, you can classify systems using the Customize Collections option of HP Systems
Insight Manager. The systems that you want to classify are controlled by the collections in the Systems by
Service Class group. You can find the collections under Systems > Shared > Systems by Service Class
in the System and Event Collections tree view from the left pane of the Systems Insight Manager home
page.
To add service classes and remove or rename existing service classes, use the Customize... option at the
top of the tree view to change the set of collections within Systems by Service Class.
To classify a system, use the Customize... option to add the system to the collection for its service class.
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For more information on changing HP Systems Insight Manager collections, see Chapter 17 Collections in
HP Systems Insight Manager in HP Systems Insight Manager User Guide available at http://
h18002.www1.hp.com/products/servers/management/hpsim/infolibrary.html.

Task: Defining rules to reduce power consumption
HP Insight Control power management supplies pre-defined rules for reducing power consumption through
the Data Center Power Control facility. To create rules specific to your environment, start with one of the
pre-defined rules, customize it for your environment, and then mark it as "Ready for Use". For more information
on defining rules, see Defining and managing rules using Data Center Power Control.

Task: Defining rules for external events
Data Center Power Control rules can be invoked manually or automatically using the mxexec command to
respond to external events.
To invoke a rule manually, use the mxexec command. For more information on mxexec command, see
mxexec command in HP Systems Insight Manager Command Line Interface Reference Guide available at
http://h18002.www1.hp.com/products/servers/management/hpsim/infolibrary.html.
To start a rule automatically, invoke the mxexec command to define a custom CMS tool that would run the
rule. For information on creating the custom CMS tools, see Chapter 19 Systems Insight Manager custom
tools in HP Systems Insight Manager User Guide available at http://h18002.www1.hp.com/products/
servers/management/hpsim/infolibrary.html. The custom CMS tools for invoking Data Center Power Control
rules must have the following settings:

• The maximum number of targets the tool can select when creating the task is None. Targets are selected
by the filters in the rule definition.

• Command with parameters: mxexec -t DCPC -A rule-ID
You can view the rule-ID for a rule in the rule list on the Data Center Power Control Rules page.

After the custom CMS tool is created, you can launch it automatically when an event occurs with Automatic
Event Handling facility of Systems Insight Manager. for more information, see Chapter 7 Automatic event
handling in HP Systems Insight Manager User Guide. You can also configure this as a scheduled task with
Scheduled Tasks facility of Systems Insight Manager. For information on managing tasks, see HP Systems
Insight Manager User Guide.

Task: Delegating rule authorization for operators
You can authorize users, who perform the role of an operator, to run certain required rules using the Data
Center Power Control facility.
To authorize an operator to run a rule, perform the following:
1. From the New Rule or Edit Rule section of the Data Center Power Control Rules page, click Permissions.

The Permissions section appears at the bottom of the New Rule or Edit Rule section of the Data Center
Power Control Rules page.

2. Select the operator name from the Other users column and click to move it into the Users with explicit
permission to run the rule column to add permission to the user for this rule. You can also include
permission for more than one user for a rule.

3. Click Save Permissions to save the changes. The operator is authorised to run the required rules.
For more information on deleting user permissions, see Adding/Deleting user permissions.
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Support and other resources
Information to collect before contacting HP

Be sure to have the following information available before you contact HP:

• Software product name

• Hardware product model number

• Operating system type and version

• Applicable error message

• Third-party hardware or software

• Technical support registration number (if applicable)

How to contact HP
Use the following methods to contact HP technical support:

• In the United States, see the Customer Service / Contact HP United States website for contact options:
http://welcome.hp.com/country/us/en/contact_us.html

• In the United States, call 1-800-HP-INVENT (1-800-474-6836) to contact HP by telephone. This service
is available 24 hours a day, 7 days a week. For continuous quality improvement, conversations might
be recorded or monitored.

• In other locations, see the Contact HP Worldwide website for contact options:
http://welcome.hp.com/country/us/en/wwcontact.html

Registering for software technical support and update service
HP Insight software includes one year of 24 x 7 HP Software Technical Support and Update Service. This
service provides access to HP technical resources for assistance in resolving software implementation or
operations problems.
The service also provides access to software updates and reference manuals, either in electronic form or on
physical media as they are made available from HP. Customers who purchase an electronic license are
eligible for electronic updates only.
With this service, Insight software customers benefit from expedited problem resolution as well as proactive
notification and delivery of software updates. For more information about this service, see the following
website:
http://www.hp.com/services/insight
Registration for this service takes place following online redemption of the license certificate.

How to use your software technical support and update service
After you have registered, you will receive a service contract in the mail containing the Customer Service
phone number and your Service Agreement Identifier (SAID). You need your SAID when you contact technical
support. Using your SAID, you can also go to the Software Update Manager (SUM) web page at http://
www.itrc.hp.com to view your contract online and elect electronic delivery for product updates.

Warranty information
HP will replace defective delivery media for a period of 90 days from the date of purchase. This warranty
applies to all Insight software products.
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HP authorized resellers
For the name of the nearest HP authorized reseller, see the following sources:

• In the United States, see the HP U.S. service locator website:
http://www.hp.com/service_locator

• In other locations, see the Contact HP worldwide website:
http://welcome.hp.com/country/us/en/wwcontact.html

Documentation feedback
HP welcomes your feedback. To make comments and suggestions about product documentation, send a
message to:

docsfeedback@hp.com

Include the document title and manufacturing part number in your message. All submissions become the
property of HP.

New and changed information in this edition
This is the first edition of this user guide providing the user with information on HP Insight Control power
management.

Related information
Documents

• HP Insight Control documentation:
http://www.hp.com/go/insightcontrol/docs

• HP Systems Insight Manager documentation:
http://h18002.www1.hp.com/products/servers/management/hpsim/infolibrary.html

Websites

• HP Insight Control:
http://www.hp.com/go/insightcontrol

• HP Insight Control power management:
http://www.hp.com/go/ipm

• HP Systems Insight Manager:
http://www.hp.com/go/hpsim

• HP Power Regulator:
http://www.hp.com/servers/power-regulator

• HP Dynamic Power Capping:
http://h18004.www1.hp.com/products/servers/management/dynamic-power-capping

• HP ProLiant BL BladeSystem servers:
http://www.hp.com/go/blades

• HP ProLiant DL series servers:
http://www.hp.com/servers/dl

• HP ProLiant ML series servers:
http://www.hp.com/servers/ml

60 Support and other resources

http://www.hp.com/service_locator
http://welcome.hp.com/country/us/en/wwcontact.html
mailto:docsfeedback@hp.com
http://www.hp.com/go/insightcontrol/docs
http://h18002.www1.hp.com/products/servers/management/hpsim/infolibrary.html
http://www.hp.com/go/insightcontrol
http://www.hp.com/go/ipm
http://www.hp.com/go/hpsim
http://www.hp.com/servers/power-regulator
http://h18004.www1.hp.com/products/servers/management/dynamic-power-capping
http://www.hp.com/go/blades
http://www.hp.com/servers/dl
http://www.hp.com/servers/ml


Typographic conventions
This document uses the following typographical conventions:
Book title The title of a book. On the web, this can be a hyperlink to the book itself.
Command A command name or command phrase, for example ls -a.
Computer output Information displayed by the computer.
Ctrl+x or Ctrl-x A key sequence that indicates you must hold down the keyboard key labeled

Ctrl while you press the letter x.
ENVIRONMENT VARIABLE The name of an environment variable, for example, PATH.
Key The name of a keyboard key. Return and Enter both refer to the same

key.
Term A term or phrase that is defined in the body text of the document, not in a

glossary.
User input Indicates commands and text that you type exactly as shown.
Replaceable The name of a placeholder that you replace with an actual value.
[ ] In command syntax statements, these characters enclose optional content.
{ } In command syntax statements, these characters enclose required content.
| The character that separates items in a linear list of choices.
... Indicates that the preceding element can be repeated one or more times.
WARNING An alert that calls attention to important information that, if not understood

or followed, results in personal injury.
CAUTION An alert that calls attention to important information that, if not understood

or followed, results in data loss, data corruption, or damage to hardware
or software.

IMPORTANT An alert that calls attention to essential information.
NOTE An alert that contains additional or supplementary information.
TIP An alert that provides helpful information.
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A Command reference
Power Management commands

This reference section contains detailed descriptions of the Insight Control power management commands.

• ipm(1M) - Insight Control Power Management Command Line Tools
• ipmexport(1M) - Insight Control Power Management database to text conversion tool
• ipmimport(1M) - Insight Control Power Management Topology Data Command Line Import Tool
• ipmtab2txt(1M) - Insight Control Power Management spreadsheet table to text conversion tool
• ipmtxt2tab(1M) - Insight Control Power Management text to table conversion tool
• ipmvis2txt(1M) - Insight Control Power Management visual xls to text conversion tool
• ipmtxt2vis(1M) - Insight Control Power Management text to visual xls conversion tool
• ipmxml2txt(1M) - Insight Control Power Management XML to text conversion tool
• ipmtxt2xml(1M) - Insight Control Power Management text to XML conversion tool

ipm(1M)

NAME
ipm - Insight Control Power Management Command Line Tools

SYNOPSIS
/opt/ipm/bin/ipminitconfig
/opt/ipm/bin/ipmimport input_text_file
/opt/ipm/bin/ipmtxt2xml input_text_file
/opt/ipm/bin/ipmtxt2tab input_text_file output_xls_file
/opt/ipm/bin/ipmtxt2vis input_text_file output_xls_file
/opt/ipm/bin/ipmexport
/opt/ipm/bin/ipmtab2txt input_xls_file
/opt/ipm/bin/ipmxml2txt input_xml_file
/opt/ipm/bin/ipmvis2txt input_xls_file

DESCRIPTION
HP Insight Control power management (IPM) is tightly integrated with other HP products like the Systems
Insight Manager (HPSIM). IPM has comprehensive graphical user interfaces for describing, monitoring, and
controlling data center power infrastructure. In addition, several command line tools may be used during
the initial installation and configuration stages of the product. See the IPM User Guide for complete
information, but a brief overview will be presented below.

GUI ACCESS
Use of any commands or graphic user interface assumes that HPSIM is installed on a Central Management
Server (CMS) and Discovery has been run. Follow the "Getting Started" section in the IPM Users Guide to
enable IPM and license systems for IPM. To log on to HPSIM, type the URL "http://cmsHostName:280/"
into the navigation bar. Then enter the administrator's user name (usually root or Administrator) and password
on the sign-in screen. Clicking "All Systems" or "All Racks" on the left shows the currently configured hierarchy.
To get to the graphical rack editor, pick an existing rack from a list on the left, click the Power/Thermal tab,
and then click Edit Rack. To create a new rack through the GUI, use the menu "Tools->Integrated
Consoles->Power Management" then click "Define Rack/Power".

CONVERSION TOOLS
All data center administrators store information about their power and server infrastructures in slightly different
formats. All of these models share two critical common elements: the unique name of each node (also known
as a Configuration Item), and how it is related spatially or electrically to other nodes (also known as a
topology). One topology traces the rack and row of every device in the data center. Another topology traces
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the flow of current from the panels to the device. Defining the nodes and relationships well is essential to
proper data center design, growth, analysis, and control. To make definition convenient, HP provides a set
of conversion tools to go from an existing format to a common, simple, unambiguous text format. Once in
that common format, any user can be permitted to combine or edit these files on any platform. Then users
can convert back to any other supported data format, including an update of the HPSIM configuration
database via ipmimport. Data can then be viewed and moved more easily in the intuitive IPM graphical
editor.
These command line tools are meant for new specifications only, not for modifying existing rack configurations.
One may reference devices already in IPM, but for modifying any existing relationships, the IPM rack editor
must be employed.
Supported formats include (name, to text tool, from text tool):

( ipmexport, ipmimport )

HPSIM database.

IPM

( ipmxml2txt, ipmtxt2xml )

HPSIM markup language, see mxnode -lf for sample

XML

( ipmvis2txt, ipmtxt2vis )

Spreadsheet visual representation of rack and row, with device U
locations and height specified by cell positions. This view represents
spatial relations that a person might see actually standing in the
data center.

VIS

( ipmtab2txt, ipmtxt2tab )

Spreadsheet tabular representation produced by a Configuration
Management Database (CMDB) where the column headings are
the attribute names and each line is a separate device.

TAB

Examples of each format and assorted use cases appear in /opt/ipm/examples. Details of each tool
appear in separate man pages, but here are some highlights. The text or XML outputs go to standard out
and can be redirected to a file. Error messages are routed to standard error, but the tools will attempt to
generate as complete a conversion as possible in spite of problems. Corrections may be applied to either
the original input and reconverted or the result can be amended, whichever is easier. Only the users with
database write permissions may execute ipmimport. XML files could be imported directly into HPSIM with
mxnode -af but relationships such as device to rack mapping can be lost in this process. Although both
produce spreadsheets, the text to TAB tool creates a tabular format, and text to VIS creates a visual
representation. Print outs of both formats together may be thought of as a lab notebook, or a quick data
center reference document when a computer screen is not available.

COMMON FORMAT
The common text format expresses information in terms of attribute:value pairs. Attribute names are not case
sensitive.
Attributes that are accepted in every format are listed below, along with their type. Unsigned integers are
always 0 or greater. String values may contain any alphanumeric, space, colon, apostrophe, parenthesis,
dash, period, underscore, tilde, Hiragana, Katakana, or the unified CJK character set.

TYPENAME

StringDataCentreID

StringDeviceType

UnsignedenclStartU

UnsignedHeightU

UnsignedipmMaxPower

UnsignedStartU

UnsignedPositionRow

UnsignedrackHeight

StringRackName

UnsignedRowNumber

StringSerialNumber
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The following attributes are recognized in specific formats only.

FORMATSTYPENAME

TAB, textStringCircuitName

All but XMLStringDeviceName

TAB, textStringDeviceSubType

TAB, textUnsignedenclEndU

TAB, textUnsignedEndU

TAB, textUnsignedipmBreakerCapacity

TAB, textUnsignedipmDeratedBreakerCapacity

TAB, textUnsignedipmLineVoltage

TAB, textStringIPMPoweredBy

TAB, textStringipmPowerIdentifier

TAB, textUnsignedipmPowerLimit

TAB, textUnsignedipmPowerOutputs

TAB, textStringipmSide

TAB, textStringmanagedByDevice

Note that the value of "ipmSide" for a circuit is limited to "A" for primary power or "B" for backup power,
usually used for racks that have redundant power. A circuit with no side specified defaults to "A".
Lines beginning with a # sign are treated as comments. The convention for setting any attribute is
attribute:value.
DatacentreID:Lab5
Objects appear in a hierachy, with the container first, and the members below it indented. Everything related
to a device appears on a single line of the text file separated by commas.
RowNumber:1
    RackName:southamerica, PositionRow:8, rackHeight:48
        DeviceName:peru, StartU:5, HeightU:2

Circuits don't have such a clear hierarchy, but text output tools do group and indent for readability.
CircuitName:PDU1, DeviceSubType:PDU
    CircuitName:PAN1, DeviceSubType:Panel, IPMPoweredBy:PDU1
        CircuitName:BRK1, DeviceSubType:Breaker, IPMPoweredBy:PAN1
            CircuitName:OUT1, DeviceSubType:Power Strip, IPMPoweredBy:BRK1
    CircuitName:PAN2, DeviceSubType:Panel, IPMPoweredBy:PDU1

When a device is powered by multiple circuits, list them all, separated by the & (ampersand) delimiter. See
file /opt/ipm/examples/redundant.txt for complete examples.
   DeviceName:alaska, IPMPoweredBy:SIDEA_Outlet & SIDEB_Outlet

ALIASES
The attribute names shown above are the official HPSIM attribute names. However, different sites call these
attributes by different names, sometimes in different languages. By using aliases, IPM allows administrators
to express attributes in their own language. In a special /var/opt/ipm/conf/alias.txt file,
administrators expand on the current examples.
   #  This is a list of alternate keywords that the IPM tools can
   #  recognize. Format for any pair is
   #    alias : HPSIM keyword
   #  Pairs may be delimited by comma, or newline.
   #  Comments and leading spaces are ignored.
   #  Below are examples

Data Center Id : DataCentreID
Lab : DataCentreID
Start: StartU, Height:HeightU

# These aliases are transitive. Use the short form once established.
Altura: Start
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Hauteur: Start

If a non-administrator wishes to create a personal alias file, set and export the shell variable IPMALIASFILE
to the alternate file name.

RETURN VALUES
The command line tools return exit status based on the success or failure of the operation.
0 No errors.
1 Errors in the command - line arguments, or missing spreadsheet content.

DIAGNOSTICS
The command line tools display error messages in stderr for any of the following conditions:
+ An invalid filename is specified.
+ Data center, Row, or Rack labels are missing.
+ Invalid heights, or attribute names are used.
+ Duplicate names are discovered.
+ User attempted to modify existing rack, or move an already-affiliated device.

EXAMPLES FILES
/opt/ipm/examples is a directory containing examples of converted files and formats.
/var/opt/ipm/conf/alias.txt is a mapping of site-specific words to official HPSIM attribute names.

AUTHORS
The IPM conversion and configuration tools were developed by the Hewlett-Packard Company.

SEE ALSO
ipmimport(1M), ipmexport(1M), ipmtxt2tab(1M), ipmtxt2vis(1M), ipmtxt2xml(1M),
ipmtab2txt(1M), ipmxml2txt(1M), ipmvis2txt(1M).

ipmexport(1M)

NAME
ipmexport - Insight Control Power Management database to text conversion tool

SYNOPSIS
ipmexport

DESCRIPTION
The purpose of this tool is to convert the HPSIM database representation of data center topology by device,
rack, and row into a flat text representation. Because this tool requires the IPM database, it must be run from
an active HPSIM Central Management Server (CMS) node by a user with database read permission. This
tool writes to standard out and can be redirected to a file. After converting to this common text format, users
can edit the topology on any operating system. Users can then convert this text file to any supported format.
Frequently, output from this tool is used to make a spreadsheet lab notebook with all current data.
Note that large data centers can take several minutes to read. If the tool generates a time-out error, the CMS
may need more memory to hold all the objects. But the tool will print everything it had memory for.

RETURN VALUES
The ipmexport command returns exit status based on the success or failure of the operation.
0 No errors.
1 Errors in the command-line arguments, permissions, database connectivity, or missing required content."
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DIAGNOSTICS
ipmexport displays error messages in stderr for any of the following conditions:
+ Machine run on is not an active HPSIM CMS.
+ User has no HPSIM credentials
+ HPSIM is not running, often indicated by ConnectException or Connection refused message. In this
instance, try mxstart, and wait for the cimserver and mxdomainmgr daemons to come up before trying the
ipmexport command again.

FILES
/opt/ipm/examples is a directory containing examples of converted files and formats.

AUTHORS
ipmexport was developed by the Hewlett-Packard Company.

SEE ALSO
ipm(1M), ipmimport(1M), ipmtxt2vis(1M).

ipmimport(1M)

NAME
ipmimport - Insight Control Power Management Topology Data Command Line Import Tool

SYNOPSIS
/opt/ipm/bin/ipmimport input_text_file

DESCRIPTION
The purpose of this tool is to load a text representation of data center topology by device, rack, and row
into the HPSIM database. Because this tool requires the IPM database, it must be run from an active HPSIM
Central Management Server (CMS) node by a user with database write permission. The common
attribute:value text format is described in ipm.1m in detail.
Note that importing of large numbers of devices and relationships can take on the order of a few creations
per second. Every twenty write operations the tool will print out a "." character to let the user know that
forward progress is being made. If progress stalls out, the CMS may need more memory. Please see the HP
Systems Insight Manager Installation and Configuration Guide for details about resource requirements
(http://www.hp.com/go/hpsim).

EXAMPLES
This is a sample input file. Case and spacing are ignored by the parser.
DatacentreID:Lab5
RowNumber:1
    RackName:southamerica, PositionRow:8, rackHeight:48
        DeviceName:ecuador, StartU:17, HeightU:4
        DeviceName:bolivia, StartU:13, HeightU:8
        DeviceName:peru, StartU:5, HeightU:2

To clearly identify the changes made by the import, save a snapshot of the existing HPSIM configuration
using
   ipmexport > /tmp/before

After ipmimport datacenterFilename.txt succeeds, find out the new representation in the HPSIM database
using
   ipmexport > /tmp/after

Devices without any parent rack specified are known as "orphans". Compare the "orphaned devices" section
of the before and after snapsots to find recently imported items considered to be orphans. There are several
reasons that devices are orphaned. Verify that the device in question are up using ping. Sometimes, the
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reason is a typographical error in the text file, such as "o" instead of zero in a name, or the device may be
gone permanently. Remove erroneous names using the mxnode -r name command. Perform another import
with just the corrected names in a smaller text file.
Sometimes, the device name really refers to a Complex or Npartition. In this case, find out what the official
complex name is on one of its nodes using the parstatus command. If this complex does not already show
up in the orphan list, add it by adding one of the member nodes to HPSIM via the mxnode -a name
command. Often, complexes are the only item in a rack. In this case, remove the erroneous name, replace
the old name in the text file
DatacentreID:Lab5
Row:6
    RackName:CentralAmerica, PositionRow:7, rackHeight:42
        DeviceName:panama, StartU:30, HeightU:11

with the new name and type and re-imported.
DatacentreID:Lab5
Row:6
    RackName:CentralAmerica, PositionRow:7, rackHeight:42
        DeviceName:canal 1, DeviceType:Complex, StartU:30, HeightU:11

If there are other devices in a rack to be corrected, the entire rack may be erased using mxnode -r
CentralAmerica and readded with another ipmimport subset.txt command.
Orphaned racks are rare, and usually indicate a rack that has no data center assigned yet, or an automatically
discovered enclosure rack name that doesn't match the expected value. To fix the reported value during
discovery, log on to the GUI for the blade system's Onboard Administrator (OA), change the rack name to
match by clicking Enclosure Information, then Information tab. Remember that names in HPSIM must be
unique. Finally, remove any any unwanted names using mxnode -r. For bulk removal, generate an XML
version of the device using ipmtxt2xml textfile > xmlfile followed by the command mxnode
-rf xmlfile

RETURN VALUES
The import command returns exit status based on the success or failure of the operation.
0 No errors.
1 Errors in the command-line arguments, permissions, database connectivity, or missing required content."

DIAGNOSTICS
ipmimport displays error messages in stderr for any of the following conditions:
+ Machine run on is not an active HPSIM CMS.
+ User has no HPSIM credentials
+ HPSIM is not running, often indicated by ConnectException or Connection refused message. In this
instance, try mxstart, and wait for the cimserver and mxdomainmgr daemons to come up before trying the
ipmexport command again.
+ Syntax error in the text input file

FILES
/opt/ipm/examples is a directory containing examples of converted files and formats.

AUTHORS
ipmimport was developed by the Hewlett-Packard Company.

SEE ALSO
ipm(1M), ipmexport(1M).

ipmtab2txt(1M)

NAME
ipmtab2txt - Insight Control Power Management spreadsheet table to text conversion tool
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SYNOPSIS
ipmtab2txt input_file_name

DESCRIPTION
The purpose of this tool is to convert a spreadsheet tabular representation of data center topology generated
from a Configuration Management Database (CMDB) into a flat text representation. This tool writes to
standard out and can be redirected to a file. After converting to this common text format, users can edit the
topology on any operating system. Users can then convert this text file to any supported format, but the most
common use for this file is to then import the device names and relationships into IPM via the ipmimport
command. Any user with file permissions can read a spreadsheet or text file, but only the superuser may
execute ipmimport.
The common attribute:value text format is described in ipm.1m in detail.
There are four kinds of spreadheet rows (lines). Different formats cannot be mixed on the same line or errors
will be generated.
Attribute:value

Attributes set in this way persist for the whole sheet. This is a handy way to set defaults for
incomplete lines or to avoid typing for data that is repeated. The pair DatacentreID:string
in the first attribute:value cell of the workbook is required. Other settings line RackHeight:48,
DeviceHeight:1 are common shortcuts. These defaults are cumulative and apply to every
line following. The values may be changed within the spreadsheet, and the new default
applies to every line following that change.

Heading

At the top of each column in a table, include a label to identify what this column contains,
such as DeviceType or RowNumber. These labels will be the attribute name for all values
below them until another heading line appears. Each heading line must contain either
DeviceName, CircuitName, or RackName to be legal. Heading lines should not have any
gaps, as empty cells in the sequence are not currently supported.

Value

Each line contains all known data about a given rack or device necessary to uniquely
identify it. Empty fields are set to default values if defaults have been set; otherwise, they
will generate errors.

Blank

This line type is used for spacing and readability and is ignored by the parser.

EXAMPLES
This tool extracts as much information as it can, even with errors. Follow the error indicators, correct the
input sheet, and reconvert. It may take a couple of iterations to get the output to look exactly as expected.
This is a sample text output file.
DatacentreID:hemisphere
RowNumber:1
    RackName:northamerica, PositionRow:1, rackHeight:42
    RackName:southamerica, PositionRow:2, rackHeight:18
        DeviceName:ecuador, StartU:17, HeightU:4
        DeviceName:bolivia, StartU:13, HeightU:8
        DeviceName:peru, StartU:5, HeightU:2

In the input file, the DatacentreID:name should appear in the file line. Specify racks before devices. If no
PositionRow field is specified, list racks in physical order, not alphabetical order. Otherwise, the ordering
of lines has no meaning. The ordering of heading labels is not important as long as it matches the data
underneath.
  |  A                     |   B        |   C          |   D
--+------------------------+------------+--------------+--------
 1|DatacentreID:hemisphere |            |              |
  |RowNumber:1             |            |              |
--+------------------------+------------+--------------+--------
 2|RackName                | RackHeight | PositionRow  |
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--+------------------------+------------+--------------+--------
 3|northamerica            | 42         | 1            |
--+------------------------+------------+--------------+--------
 4|southamerica            | 18         | 2            |
--+------------------------+------------+--------------+--------
 5|                        |            |              |    
--+------------------------+------------+--------------+--------
 6|DeviceName              | HeightU    | RackName     | StartU
--+------------------------+------------+--------------+--------
 7|bolivia                 | 8          | southamerica | 13
--+------------------------+------------+--------------+--------
 8|ecuador                 | 4          | southamerica | 17
--+------------------------+------------+--------------+--------
 9|peru                    | 2          | southamerica |  5
--+------------------------+------------+--------------+--------

RETURN VALUES
The ipmtab2txt command returns exit status based on the success or failure of the operation.
0 No errors.
1 Errors in the command-line arguments, permissions, missing files, missing arguments, or the file is missing
required labels.

DIAGNOSTICS
ipmtab2txt displays error messages in stderr for any of the following conditions:
+ Missing or unrecognized arguments.
+ File not found or not readable.
+ Syntax error in the input file
An obscure file read error in jxl usually means that the file was ftp'd in ASCII mode instead of binary mode.
Type 'bin' at the ftp prompt to avoid this corruption.

FILES
/opt/ipm/examples is a directory containing examples of converted files and formats.

AUTHORS
ipmtab2txt was developed by the Hewlett-Packard Company.

SEE ALSO
ipm(1M), ipmimport(1M), ipmtxt2vis(1M).

ipmtxt2tab(1M)

NAME
ipmtxt2tab - Insight Control Power Management text to table conversion tool

SYNOPSIS
ipmtxt2tab input_text_file output_xls_file

DESCRIPTION
The purpose of this tool is to convert a flat text representation of data center topology by device, rack, and
row into an xls file tabular (TBL) representation of every rack and device alphabetized by name. This procedure
creates a lab notebook, a paper reference copy of all current topology data (see ipmexport). If the output
file name already exists, the tool will exit with an error, forcing the user to remove or rename the output file
name.
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Any user with file permissions can read a spreadsheet or text file. The common attribute:value text format is
described in ipm.1m in detail.

EXAMPLES
See ipmtab2txt.1m for an example out what tabular output format looks like. This is a sample input file.
Case and spacing are ignored by the parser.
DatacentreID:Lab5
RowNumber:0
    RackName:southamerica, PositionRow:8, rackHeight:48
        DeviceName:ecuador, StartU:17, HeightU:4
        DeviceName:bolivia, StartU:13, HeightU:8
        DeviceName:peru, StartU:5, HeightU:2

RETURN VALUES
The ipmtxt2tab command returns exit status based on the success or failure of the operation.
0 No errors.
1 Errors in the command-line arguments, permissions, missing files, missing arguments, or missing required
content."

DIAGNOSTICS
ipmtxt2tab displays error messages in stderr for any of the following conditions:
+ Missing or unrecognized arguments.
+ File not found or not readable.
+ Output file already exists
+ Syntax error in the text input file. An obscure file read error in jxl usually means that the file was ftp'd in
ASCII mode instead of binary mode. Type 'bin' at the ftp prompt to avoid this corruption.

FILES
/opt/ipm/examples is a directory containing examples of converted files and formats.

AUTHORS
ipmtxt2tab was developed by the Hewlett-Packard Company.

SEE ALSO
ipm(1M), ipmexport(1M).

ipmvis2txt(1M)

NAME
ipmvis2txt - Insight Control Power Management visual xls to text conversion tool

SYNOPSIS
ipmvis2txt input_file_name

DESCRIPTION
The purpose of this tool is to convert a spreadsheet visual representation (VIS) of data center topology by
device, rack, and row into a flat text representation. This tool writes to standard out and can be redirected
to a file. After converting to this common text format, users can edit the topology on any operating system.
Users can then convert this text file to any supported format, but the most common use for this file is to then
import the device names and relationships into IPM via the ipmimport command. Any user with file permissions
can read a spreadsheet or text file, but only the superuser may execute ipmimport
The common attribute:value text format is described in ipm.1m in detail.
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The conversion process can vary by site depending on the input spreadsheet style. The only requirements
are for the DatacentreID:string in the first attribute:value cell of the first column of the workbook, and
rackHeight:number above each rack column on the sheet. Often, people keep comments on the spreadsheet
regarding heat dissipation and future plans. The comments may result in errors. Modify your spreadsheet
to ignore comments by
+ Starting the line with a # symbol to denote a comment.
+ Adding a keyword filter in /var/opt/ipm/conf/xls_ignore.txt
+ Creating a personal keyword filter file, and setting the shell variable IPMIGNOREFILE to a file name.
Getting the desired output may require a few iterations, but shouldn't take more than a few minutes per
sheet.

EXAMPLES
This is a sample text output file.
DatacentreID:hemisphere
RowNumber:1
    RackName:southamerica, PositionRow:1, rackHeight:18
        DeviceName:ecuador, StartU:17, HeightU:4
        DeviceName:bolivia, StartU:13, HeightU:8
        DeviceName:peru, StartU:5, HeightU:2

To achieve this format, modify an existing spreadsheet to have the data center and row labels in the first
row and column. Multiple lines in a cell are done by inserting an ALT-ENTER.
Order the racks from left to right, with devices directly below the rack label cell. Only the name of the device
needs to be present. Each cell on the spreadsheet represents a U on the rack. Use background color differences
or multi-cell ranges to represent devices taller than one unit. This is an example input sheet layout with labels
added and the "(empty)" comment appended to the /var/opt/ipm/conf/xls_ignore.txt file.
  |  A                     |   B                   |     C
--+------------------------+-----------------------+----------------------
 1|DatacentreID:hemisphere |                       |
  |RowNumber:1             |                       |
--+------------------------+-----------------------+----------------------
 2|                        | RackName:southamerica | RackName:northamerica
  |                        | rackHeight:18         | rackHeight:18
--+------------------------+-----------------------+----------------------
 3|    U18                 | (empty)               | alaska
--+------------------------+-----------------------+----------------------
 4|    U17                 | ecuador               | canada
--+------------------------+                       +
 5|    U16                 |                       |
--+------------------------+                       +
 6|    U15                 |                       |
--+------------------------+                       +----------------------
 7|    U14                 |                       | USlower48
--+------------------------+-----------------------+
 8|    U13                 | bolivia               |
--+------------------------+                       +
 9|    U12                 |                       |
--+------------------------+                       +
10|    U11                 |                       |
--+------------------------+                       +
11|    U10                 |                       |
--+------------------------+                       +----------------------
12|    U9                  |                       | mexico
--+------------------------+                       +
13|    U8                  |                       |
--+------------------------+                       +
14|    U7                  |                       |
--+------------------------+                       +
15|    U6                  |                       |
--+------------------------+-----------------------+
16|    U5                  | peru                  |
--+------------------------+                       +
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17|    U4                  |                       |
--+------------------------+                       +
18|    U3                  |                       |
--+------------------------+                       +
19|    U2                  |                       |
--+------------------------+                       +
20|    U1                  |                       |
--+------------------------+-----------------------+----------------------

RETURN VALUES
The ipmvis2txt command returns exit status based on the success or failure of the operation.
0 No errors.
1 Errors in the command-line arguments, permissions, missing files, missing arguments, or the file is missing
required labels."

DIAGNOSTICS
ipmvis2txt displays error messages in stderr for any of the following conditions:
+ Missing or unrecognized arguments.
+ File not found or not readable.
+ Output file already exists
+ Syntax error in the text input file

FILES
/var/opt/ipm/conf/xls_ignore.txt The list of keywords (devices, comments) to ignore in a
spreadsheet. Keywords are separated by spaces or newlines. Comment lines begin with a # symbol.
/opt/ipm/examples is a directory containing examples of converted files and formats.

AUTHORS
ipmvis2txt was developed by the Hewlett-Packard Company.

SEE ALSO
ipm(1M), ipmimport(1M), ipmtxt2vis(1M).

ipmtxt2vis(1M)

NAME
ipmtxt2vis - Insight Control Power Management text to visual xls conversion tool

SYNOPSIS
ipmtxt2vis input_text_file output_xls_file

DESCRIPTION
The purpose of this tool is to convert a flat text representation of data center topology by device, rack, and
row into an xls spreadsheet visual (VIS) representation of every row of the data center. This procedure creates
a lab notebook, a paper reference copy of all current topology data (see ipmexport). If the output file name
already exists, the tool will exit with an error, forcing the user to remove or rename the output file name.
Any user with file permissions can read a spreadsheet or text file. The common attribute:value text format is
described in ipm.1m in detail.

EXAMPLES
See ipmvis2txt.1m for an example out what VIS output format looks like. This is a sample input file. Case
and spacing are ignored by the parser.
DatacentreID:Lab5
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RowNumber:1
    RackName:southamerica, PositionRow:8, rackHeight:48
        DeviceName:ecuador, StartU:17, HeightU:4
        DeviceName:bolivia, StartU:13, HeightU:8
        DeviceName:peru, StartU:5, HeightU:2

RETURN VALUES
The ipmtxt2vis command returns exit status based on the success or failure of the operation.
0 No errors.
1 Errors in the command-line arguments, permissions, missing files, missing arguments, or missing required
content."

DIAGNOSTICS
ipmtxt2vis displays error messages in stderr for any of the following conditions:
+ Missing or unrecognized arguments.
+ File not found or not readable.
+ Output file already exists
+ Syntax error in the text input file

FILES
/opt/ipm/examples is a directory containing examples of converted files and formats.

AUTHORS
ipmtxt2vis was developed by the Hewlett-Packard Company.

SEE ALSO
ipm(1M), ipmexport(1M).

ipmxml2txt(1M)

NAME
ipmxml2txt - Insight Control Power Management XML to text conversion tool

SYNOPSIS
ipmxml2txt input_xml_file

DESCRIPTION
The purpose of this tool is to convert a HPSIM XML representation of data center topology by device, rack,
and row into a flat text representation. The input may be created by mxnode -lf. Relationships between
device and rack can be described solely in the text file or synthesized in the XML using the artificial
<sw-attribute name="RackName">southamerica</sw-attribute>
This tool writes to standard out and can be redirected to a file. Any user with file permissions can read an
xml or text file. The common attribute:value text format is described in ipm.1m in detail.
To make this XML unambiguous, the first node must either be a rack with the DatacentreID sw-attribute set,
or be a device with the hw-attribute DeviceType set to data center (see examples).

EXAMPLES
This is a sample text output file. Case and spacing are ignored by the parser.
DatacentreID:second_floor_bldgA
RowNumber:1
    RackName:southamerica, PositionRow:8, rackHeight:48
        DeviceName:ecuador, StartU:17, HeightU:4
        DeviceName:bolivia, StartU:13, HeightU:8
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        DeviceName:peru, StartU:5, HeightU:2

This is a sample XML input:
<?xml version="1.0" encoding="ISO-8859-1"?>
<node-list>
    <node name="second_floor_bldgA">
        <hw-attribute name="DeviceType">Datacenter</hw-attribute>
    </node>
    <node name="southamerica">
        <hw-attribute name="DeviceType">Rack</hw-attribute>
        <sw-attribute name="DataCentreID">second_floor_bldgA</sw-attribute>
        <sw-attribute name="RowNumber">1</sw-attribute>
        <sw-attribute name="PositionRow">8</sw-attribute>
        <sw-attribute name="rackHeight">48</sw-attribute>
    </node>
    <node name="ecuador">
        <sw-attribute name="StartU">17</sw-attribute>
        <sw-attribute name="HeightU">4</sw-attribute>
        <sw-attribute name="RackName">southamerica</sw-attribute>
    </node>
    <node name="bolivia">
        <hw-attribute name="DeviceType">Server</hw-attribute>
        <sw-attribute name="StartU">13</sw-attribute>
        <sw-attribute name="HeightU">8</sw-attribute>
        <sw-attribute name="RackName">southamerica</sw-attribute>
    </node>
    <node name="peru">
        <hw-attribute name="DeviceType">Server</hw-attribute>
        <sw-attribute name="StartU">5</sw-attribute>
        <sw-attribute name="HeightU">2</sw-attribute>
        <sw-attribute name="RackName">southamerica</sw-attribute>
    </node>
    </node-list>

RETURN VALUES
The ipmxml2txt command returns exit status based on the success or failure of the operation.
0 No errors.
1 Errors in the command-line arguments, or missing required content.

DIAGNOSTICS
ipmxml2txt displays error messages in stderr for any of the following conditions:
+ Missing or unrecognized arguments.
+ File not found or not readable.
+ Output file already exists
+ Syntax error in the text input file

FILES
/opt/ipm/examples is a directory containing examples of converted files and formats.

AUTHORS
ipmxml2txt was developed by the Hewlett-Packard Company.

SEE ALSO
ipm(1M), ipmtxt2xml(1M).
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ipmtxt2xml(1M)

NAME
ipmtxt2xml - Insight Control Power Management text to XML conversion tool

SYNOPSIS
ipmtxt2xml input_text_file

DESCRIPTION
The purpose of this tool is to convert a flat text representation of data center topology by device, rack, and
row into an HPSIM XML format representation. The result is similar to that created by mxnode -lf. XML
files could be imported directly into HPSIM using mxnode -af but this is discouraged. Relationships such
device to rack mapping can be lost in this process. Use ipmimport instead.
This tool writes to standard out and can be redirected to a file. Any user with file permissions can read an
xml or text file. The common attribute:value text format is described in ipm.1m in detail.

EXAMPLES
This is a sample text input file. Case and spacing are ignored by the parser.
DatacentreID:Lab5
RowNumber:1
    RackName:southamerica, PositionRow:8, rackHeight:48
        DeviceName:ecuador, StartU:17, HeightU:4
        DeviceName:bolivia, StartU:13, HeightU:8
        DeviceName:peru, StartU:5, HeightU:2

This is a sample XML output:
<?xml version="1.0" encoding="ISO-8859-1"?>
<node-list>
    <node name="Lab5">
        <hw-attribute name="DeviceType">Datacenter</hw-attribute>
    </node>
    <node name="southamerica">
        <hw-attribute name="DeviceType">Rack</hw-attribute>
        <sw-attribute name="DataCentreID">Lab5</sw-attribute>
        <sw-attribute name="RowNumber">1</sw-attribute>
        <sw-attribute name="PositionRow">8</sw-attribute>
        <sw-attribute name="rackHeight">48</sw-attribute>
    </node>
    <node name="ecuador">
        <sw-attribute name="StartU">17</sw-attribute>
        <sw-attribute name="HeightU">4</sw-attribute>
        <sw-attribute name="Rack">southamerica</sw-attribute>
    </node>
    <node name="bolivia">
        <hw-attribute name="DeviceType">Server</hw-attribute>
        <sw-attribute name="StartU">13</sw-attribute>
        <sw-attribute name="HeightU">8</sw-attribute>
        <sw-attribute name="Rack">southamerica</sw-attribute>
    </node>
    <node name="peru">
        <hw-attribute name="DeviceType">Server</hw-attribute>
        <sw-attribute name="StartU">5</sw-attribute>
        <sw-attribute name="HeightU">2</sw-attribute>
        <sw-attribute name="Rack">southamerica</sw-attribute>
    </node>
</node-list>
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RETURN VALUES
The ipmtxt2xml command returns exit status based on the success or failure of the operation.
0 No errors.
1 Errors in the command-line arguments, or missing required content.

DIAGNOSTICS
ipmtxt2xml displays error messages in stderr for any of the following conditions:
+ Missing or unrecognized arguments.
+ File not found or not readable.
+ Output file already exists
+ Syntax error in the text input file

FILES
/opt/ipm/examples is a directory containing examples of converted files and formats.

AUTHORS
ipmtxt2xml was developed by the Hewlett-Packard Company.

SEE ALSO
ipm(1M), ipmimport(1M), ipmxml2txt(1M).
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B Troubleshooting
Insight Control power management fails to show the Power graph and I receive the message Insight Control
power management could not communicate with the Management Processor as it is not accessible.
Solution: One of the following could be the reason for getting the above mentioned message.

• Connection to Management Processor timed out due to network problem or Management Processor
being unreachable.

• Mismatch of SSL ports between power management and management processor.
Please make sure that these problems are resolved.
My power management supported system is being listed as System is not supported by Insight Control power
management.
Solution: Take the following steps to resolve the problem:
1. Verify that your system is indeed supported by the version of power management you have installed,

and that you are running the required iLO firmware versions on the managed systems. To access the
latest power management support matrix, see the instructions in the Getting started section of this
document. To view power management version information, select Help→About Insight Control
power management.

2. Check to see that the management processor is discovered and associated with the system.

NOTE: Server Management Processor association is a must to be able to view the Power details
in Insight Power Manager.

3. power management identifies the system as power management supported system. If power management
does not identify the system, run the Identification Task on both the system and its management
processor by selecting Options→Identify Systems.
Running the Identification Task will help Insight Power Manager to recognize the system as a power
management supported system.

Insight Control power management has failed to fetch the Power details and a message is displayed indicating
Unable to communicate with iLO 2 because it does not have an iLO 2 Advanced or iLO 2 Select license.
Solution: Take the following steps to resolve the problem:
1. Launch the iLO 2 web interface and assign the Advanced/Select license if the iLO 2 is not already

licensed.
2. Check to be sure the iLO 2 is associated with its system.
3. Launch the Deploy→License Manager by selecting the iLO 2 as target and click on Collect license

info....
4. SelectDeploy→License Manager to verify the iLO 2 is listed as the licensed system under the HP iLO

Advance Pack or the HP iLO Select Pack category.

NOTE: iLO 2 must appear as a licensed system in the License Manager to view the Power details from
Insight Power Manager.

5. Launch the power management page on that system and click Refresh Data to view the latest power
details.

Insight Control power management fails to show the Power graph and I receive the message Insight Control
power management could not communicate with the Management Processor.
Solution: Take the following steps to resolve the problem:
1. Make sure the system's Management Processor is discovered in Systems Insight Manager.

NOTE: System to iLO 2 association is a must to view the Power graph in Insight Power Manager.

2. Select Options→Identify Systems to run the Identification Task on the management processor and
its system to get the association.

3. Click Refresh Data to view the latest power information.
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If you select enclosures, licensed servers, and unlicensed servers to license the unlicensed servers and generate
power management reports, the selected enclosures are removed from the selected targets when you click
Previous on the License unlicensed servers page.
Solution 1: Take the following steps to resolve the problem:
1. License the unlicensed servers.
2. Select the enclosures along with the licensed servers to generate the power management reports.
Solution 2: On the License unlicensed servers page, you must not click Previous. After the unlicensed
servers are licensed and when you click Next, the enclosures are listed on the next page.
Unable to view/receive iLO 2 power threshold alerts.
Solution: Perform the following to resolve the problem:

• Using iLO 2 Web Interface, you need to configure the CMS server to receive SNMP alerts from iLO 2.
• From Systems Insight Manager, you need to configure cpqHo2PowerThresholdTrap defined in

cpqHost.mib on the SNMP Trap Settings (Options→Events→SNMP Trap Settings) page.
• On power threshold breach, iLO 2 sends SNMP alerts, which are logged against the system and can

be viewed from Events tab of the System page.
Unable to communicate with Management Processor <mpname> in server <servername>
because the Management Processor does not have a serial number and(or) network
address. Please re-identify the Management Processor and try again.

Solution: There might be a problem with duplicate iLOs associated with the system. Use the All Management
Processors view and identify the iLOs associated with the server. There is one iLO with its name being the
IP address of the iLO and another iLO with the serial number of the iLO as its system name. Delete the iLO
with no IP address recorded.
Discovery of PDU/PDR does not create Power Delivery Devices.
Solution: If the Breaker Panel, Branch Circuit, Rack PDU, or Load Segments associated with the PDU/PDR
management module are not discovered properly, verify the PDR/PDU monitoring via SNMP configuration
settings. See Configuration for PDR/PDU monitoring via SNMP . After making the required changes, select
and identify the system using Systems Insight Manager's Identify Systems option. You will see the following
identifying systems output to enable discovery/monitoring of the PDU/PDR:
* Checking for SNMP protocol support on system.
  Result: The system responded to an SNMP request;
  it supports SNMP.
...
* Checking if this system is supported by
  Insight Control power management.
* Insight Control power management is supported.

For the incorrect PDU/PDR settings, the message will be displayed as:
* Checking for SNMP protocol support on system.
  Result: The system did not respond to SNMP.
  Verify security settings and community strings
  in Options->Security->Credentials->System Credentials.
...
* Checking if this system is supported by
  Insight Control power management.
* Insight Control power management is not supported.
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Glossary
administrative
rights user

A user who is authorized for the All Tools toolbox on all systems, including the Central
Management Server. This type of user has been given special privileges to administer the Systems
Insight Manager software.

branch circuit This represents a single output of a PDR circuit breaker and the PDU to monitor the actual circuit
power consumption.

breaker panel This represents the total group of breakers on a single breaker panel in a PDR.
calibrated max
power

Sum of the maximum theoretical power consumption of all attached devices.

capacity The available or maximum power limit of the power delivery device.
Central
Management
Server (CMS)

Executes the Systems Insight Manager software. All central operations within Systems Insight
Manager are initiated from this system.

command line
interface (CLI)

A text-based application that can be executed from a command shell such as sh, csh, ksh or the
Microsoft Windows CMD shell.

Desktop
Management
Interface (DMI)

An industry-standard protocol, primarily used in client management, established by the Desktop
Management Task Force (DMTF). DMI provides an efficient means of reporting client system
problems. DMI-compliant computers can send status information to a central management system
over a network.

dynamic power
cap

A cap on a group of systems in an enclosure. As the systems run, demand for power varies for
each system. A cap for each system is set to provide the system with enough power to meets its
workload demands while still conforming to the enclosure cap. Continuous monitoring of power
demands and automatic adjustments to system caps ensure there is minimal, if any, performance
degradation.

enclosure A physical container for a set of server blades. It consists of a backplane that routes power and
communication signals and additional hardware for cabling and thermal issues. It also hosts the
CPU or server power supplies.

excess capacity The power capacity that cannot be used for the current configuration and is available in excess
to accommodate and deliver power to more systems.

headroom capacity The spare cap capacity that is identified from the difference between the peak power consumption
and power cap. This helps to identify the power delivery devices with power caps that can
accommodate another system within the already set power cap.

health status Health status is an aggregate status all of the status sources (which can be SNMP, WBEM, and
HTTP) with the most critical status being displayed.
See also system health status.

HP Insight Control Delivers foundation management capabilities that includes server deployment, server migration
health and performance monitoring, remote control, advanced power management and virtual
machine management.

HP Insight Control
power
management

Extends Systems Insight Manager with power consumption and thermal output monitoring to
optimize data center power and cooling. Includes power regulation policies for groups of HP
ProLiant and Integrity servers as well as capabilities to map power topology in a data center.

HP Insight
Software Installer

A wizard-based installer used by HP Insight software to simplify the installation, configuration,
and integration of Systems Insight Manager HP Insight Control and HP Insight Dynamics.

HP Systems Insight
Manager

Provides unified foundation management services for HP servers, storage, and network resources
from a single console. Systems Insight Manager delivers centralized fault, configuration, inventory,
performance management, warranty details, automated service call initiation and troubleshooting
information. Systems Insight Manager is built according to industry standards to manage HP and
third-party infrastructure resources.

HP Systems Insight
Manager database
(database)

The database that stores vital information about Systems Insight Manager, including users, systems,
and toolboxes.
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Integrated
Lights-Out (iLO)

Basic system management functions, diagnostics, and essential Lights-Out functionality are included
as core components of Integrated Lights-Out (iLO) supported systems. The standard features of
iLO are referred to as iLO Standard. Advanced remote administration functionality, referred to
as iLO Advanced, can be licensed with the optional Integrated Lights-Out Advanced Pack for HP
Integrity Servers.

license keys The contractual permissions granted by HP to the customer in the form of a coded embodiment
of a license that represents a specific instance of a license. A single license can be represented
by a single key or by a collection of keys.

line voltage The line voltage of the data center that is delivered to the observed device.
load The power consumer connected to the outlet. The outlet can be a system, enclosure, or

undiscoverable system.
load segment A monitorable power output on a PDU. This normally corresponds to one C19 outlet and may

be further subdivided through a power strip into C13 outlets depending upon the need.
multiple-system
aware (MSA)

A run type that supports multi-system operations. Tools with this run type operate on the target
systems using their own internal mechanisms instead of using the Distributed Task Facility. The
MSA run type uses the Distributed Task Facility to launch the tool on a single system before the
tool interacting with the other managed systems.

Onboard
Administrator

The Onboard Administrator is the central point for controlling an entire c-Class rack. It offers
configuration, power, and administrative control over the rack, and its associated blades (Compute
Servers), blade management processors, network switches (depending on the models of switches
used) and storage components (such as SAN or SATA). The Onboard Administrator is a single
management processor, with shared resources to an optional backup twin processor for failover.

operating range The center bar shows the theoretical range of minimum and maximum power consumption of the
systems being summarized.

operator rights
user

A user who has limited capability to configure the Central Management Server. operator rights
users have permission to create, modify, and delete all reports and their own tools.

outlet A circuit with one input and one output that can be monitored. This is available in the power
topology when discovered through a HP PDU..

outlet bar This represents the division of the load segment into multiple outlets.
PDU Management
Module

A PDU Management Module (MM) enables you to monitor power environments through
comprehensive control of individual HP PDUs. The module can be configured to send alert traps
to HP Systems Insight Manager and other SNMP management programs or used as a standalone
monitoring system. This flexibility enables you to monitor up to two PDUs through the network
connector or serial connector located on the front of the management module. To facilitate
day-to-day maintenance tasks, the embedded management software provides detailed system
logs. The MM is connected to one ore more PDUs (aka PDU cores). Often a single MM is used
to monitor both the SideA/SideB power in a rack even though the MM itself is not redundant.

peak observed
power

Peak of power consumption values concurrently observed for all attached devices. For
non-observable devices, the “Max” power configuration value will be used. This is not the sum
of the peak power consumption over all devices – that is a higher value than the peak sum of
power consumed at any given time.

peak observed
time

The peak observed time of the power consumption.

Power Cap Power Cap allows the user to set the wattage limit on the amount of power a system will consume.
The type of power cap is determined when selecting:

• A single system, the cap is a static single-system cap.

• Multiple systems, the cap is a static group cap. With a static group cap, each system in the
group is assigned a static linear apportionment of the total group cap.

• An enclosure, the cap is a dynamic power cap. This type of cap dynamically sets and adjusts
caps on the individual systems in the enclosure to meet workload demand while complying
with the total enclosure cap.
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NOTE: Dynamic power caps are only set when an enclosure is selected. Selecting all the
blades in an enclosure results in a static group cap.

power delivery
device

A power delivery device is anything that aggregates one or more power consumers such as PDR,
PDU, power strip, and branch circuit.

Power Distribution
Rack (PDR)

A rack module that divides redundant input power to several nearby racks.

Power Distribution
Unit (PDU)

The PDU normally takes a large IEC 309 power plug and distributes power in the rack to
C-20/C-13 plugs, which connect to the power input of servers or enclosures. Each PDU (or more
specifically PDU core) is attached to a single and independent branch circuit. For monitored
PDUs, there may be more than one PDU core that is controlled via a PDU Management Module.
In this type of configuration, the term PDU often is loosely used to refer to the management module
(since it the named entity).

power feed A top-level input of power from the Data center facility into the Power Management-observable
power infrastructure.

rack HP uses a universal rack to hold all supported rack mount hardware. Racks are measured in U
height (each U being a slot). The most common size is 42U, but HP also sells 14U, 22U, 36U,
and 47U racks. See http://www.hp.com/go/rackandpower for options.

rack PDU This represents the input power and multiple outputs to load segments, which can be two per
management module.

Simple Network
Management
Protocol (SNMP)

One management protocol supported by Systems Insight Manager. Traditional management
protocol used extensively by networking systems and most servers. Management Information Base
for Network Management of TCP/IP-based internets (MIB-II) is the standard information available
consistently across all vendors.

Simple Object
Access Protocol
(SOAP)

A lightweight protocol for exchange of information in a decentralized, distributed environment.

single-system
aware (SSA)

A run type that does not support multi-system operations. Tools with this run type are only aware
of the system on which they are running.

system Systems on the network that communicate through TCP/IP. To manage a system, some type of
management protocol (for example, SNMP, or WBEM) must be present on the system. Examples
of systems include servers, workstations, desktops, portables, routers, switches, hubs, and
gateways.

system health
status

This is aggregate status all of the status sources (which can be SNMP, WBEM, and HTTP) that
are supported on a target system, with the most critical status being displayed. The following are
the different system health statuses that can be displayed:

• Critical Systems Insight Manager can no longer communicate with the system. The system
was previously discovered but cannot be pinged. The system might be down, powered off,
or no longer accessible on the network because of network problems.

• Major A major problem exists with this system. It should be addressed immediately. For
systems running an HP Insight Management Agents, some component has failed. The system
might no longer be properly functioning, and data loss can occur.

• Minor A minor problem exists with this system. For systems running Insight Management
Agents, some component has failed but the system is still functioning.

• Warning The system has a potential problem or is in a state that might become a problem.

• Normal The system is functioning correctly.

• Disabled The system is disabled from monitoring but is not necessarily turned off.

• Unknown Systems Insight Manager cannot obtain management information about the
system.

• Informational The system might be in a transitional or non-error state.
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Web-Based
Enterprise

This industry initiative provides management of systems, networks, users, and applications across
multiple vendor environments. WBEM simplifies system management, providing better access to
software and hardware data that is readable by WBEM client applications.Management

(WBEM)
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